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Se diseñó e implementó una máquina de control numérico computarizado (CNC) para el tallado de placas de circuito impreso (PCB) para elementos de montaje superficial (SMD) con una precisión de 0.2mm, para la Escuela de Ingeniería Electrónica en Control y Redes Industriales en la Facultad de Informática y Electrónica. Esta investigación busca abaratar los costos de implementación de placas electrónicas con la utilización de software libres.    Se utilizó el método científico para el diseño del gabinete de control y adaptaciones mecánicas, y el método experimental para las respectivas pruebas de funcionamiento y el calculó de errores absolutos y relativos.    Para su implementación se usó la estructura mecánica de una maquina CNC modelo 3020T, existente en el mercado. El control del maquinado se lleva acabo con una placa Arduino UNO programado con el software GRBL diseñado para el control de máquinas CNC, el mismo que recibe las instrucciones o comandos de un ordenador a través del puerto USB, estas instrucciones son producto de un código G, que se obtiene a través de un software libre denominado FlatCam. El control de movimiento de cada uno de los ejes se realizó con el controlador JP-328A, que está diseñado a base de TB6560AHQ, además cuenta con finales de carrera para el control del desplazamiento de los ejes X; Y. Nuestra máquina a más de ser utilizada para el tallado de placas PCB, puede ser aplicado para el fresado de piezas en madera de tipo MDF de baja densidad utilizando fresas de corte adecuadas para este tipo de material. En las pruebas de fresado de 0.2mm, los resultados obtenidos dieron un error de precisión menor al 1% usando el diámetro de prueba de fresa de 0.1mm.    Concluimos que este porcentaje de error se dio porque no existe una fresa más fina, mas no por la precisión de movimiento de la máquina.    Si los estudiantes de la escuela de control requieren mayor precisión se recomienda usar una máquina de tallado a laser como las que se usan en las principales fábricas de manufacturas de PCB.    






PALABRAS CLAVES: <ELEMENTOS DE MONTAJE SUPERFICIAL [SMD]>, <PLACAS DE CIRCUITO IMPRESO [SMD]>, <SOFTWARE LIBRES>, <CONTROL NUMÉRICO COMPUTARIZADO [CNC]>, <PLACA ARDUINO>, <MÁQUINA>. 
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It was designed and implemented a machine of computing numerical control (CNC) for the carving of printed circuit boards (PCB) for superficial montage devices (SMD) with 0.2mm precision, for the School of Electronics in Control and Industrial Networks in the Faculty of Computing and Electronics. This research work aims to reduce the costs of implementation of these electronic boards by means of the use of free software.    The scientific method was used for the design of the control cabinet and mechanical adaptations, and the experimental method for the corresponding functioning test and the calculation of absolute and relative errors. For its implementations, it was used the mechanical structure of a CNC machine model 3020T, available in the market. The control of the machine was carried out with a board Arduino UNO programmed with the software GRBL designed for the control of CNC machines which receives commands and instructions from a computer through a USB port; these instructions come from a G code which is obtained through a free software called Flat Cam. The movement control of each axis was done with the JP-328A controller, which is designed based upon the TB6560AHQ, additionally it has race endings for the displacement control on X; Y axis. The machine can be used for the caving of PCB boards as well as the milling of MDF wooden pieces of low density using mills of adequate cut for this material. In the milling tests of 0.2mm, the results revealed a precision error lower than 1% by using the diameter of a mill tip of 0.1mm. As a conclusion, this error percentage resulted since there is not a thinner mill, no because of the machine movement precision. If the students of the School of Control require higher precision, it is recommended to use a laser carving machine like the ones used in the main factories which produce PCB.  
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[bookmark: _Toc436062960]INTRODUCCIÓN 


Los avances tecnológicos de la electrónica han tenido un auge a lo largo de la historia y con ello la robótica. Donde el motor principal son los circuitos eléctricos los mismos que se enlazan entre elementos a través de líneas de conducción de cobre, a esto se le conoce como PCB (Placas de Circuito Impreso).

Normalmente la tecnología que se usaba para los elementos era de tipo THT (Tecnología de Agujeros Pasantes), siendo esta remplazada por los SMD (Tecnología de Montaje Superficial), la misma que no requiere de agujeros en la placa electrónica para su montaje permitiendo que el diseño de los circuitos sea reducido.

Por tal razón el siguiente trabajo tiene como objetivo, el desarrollar una máquina que permita fabricar placas PCB para los elementos de montaje superficial ya que su tamaño es muy pequeño y por ende la separación entre pines de algunos elementos requieren de una precisión de 0.2 mm entre líneas de conducción de la placa, lo cual dificulta que sean elaborados por métodos caseros y que conllevan de mucha exactitud.

La construcción de la máquina es de tipo cartesiana con movilidad para tres ejes, esta movilidad se consigue con motores paso a paso y tornillos sin fin con el objetivo de lograr una precisión al momento de desplazar los ejes en el área de trabajo. El control de estos motores se logra a través de los drivers A4988 o JP-382A, los mismos que a su vez son controlados por un Arduino UNO.

Además de estos se utiliza los sensores finales de carrera en cada uno de los ejes para limitar el desplazamiento de los mismos y de esta manera evitar daños en la etapa de control de los motores. Para realizar el grabado en las placas de cobres se utiliza un motor de giro también conocido como husillo en máquinas CNC, la velocidad de rotación de este motor es controlado con un PWM generado por la placa JP-1482.

El control total de la máquina CNC lo lleva acabo la placa de Arduino UNO, la misma que está programada con un software libre llamado GRBL; este se encarga de interpretar el código G y traducirlo a instrucciones que son enviadas al controlador de motores para realizar los movimientos respectivos de cada eje.

La interfaz de comunicación utilizada entre máquina y PC, es por medio del puerto USB 2.0 a una velocidad de 9600 Baudios, siendo la máxima velocidad de comunicación que se puede usar con GRBL. Este software cuenta con una interfaz gráfica llamada GCODESENDER que permite realizar movimientos manuales de los ejes, control de los archivos de código G que serán enviados a la placa Arduino UNO y una visualización en tiempo real del fresado.   
    































PLANTEAMIENTO DEL PROBLEMA 


[bookmark: _Toc436062961]ANTECEDENTES


En la actualidad la comunidad electrónica del país ha tenido un gran apego por la robótica y la tecnología, la mayoría se dedican a la realización de sus propios modelos y por ende sus propios diseños de placas PCB, donde aplican el método de transferencia térmica, el cual tiene como elemento fundamental el cloruro férrico u otros ácidos que corroen el cobre.  

La aplicación de este método tiene un riesgo para la persona por el uso del ácido, puesto que contiene propiedades que son tóxicas y nocivas para la salud, además de contaminar el medio ambiente porque no tienen la debida capacitación o información sobre el desecho de este tipo de sustancias.

Con los nuevos avances de la tecnología, los elementos electrónicos son cada vez más pequeños, a esta tecnología se le conoce como SMD (Tecnología de Montaje Superficial). 

Esta tecnología SMD tuvo su aparición por los años 1960 y un gran auge en el año 1980. Su desarrollo se debe gracias a la colaboración de dos grandes empresas tales como: IBM y Siemens. Esta tecnología consistió en una modificación en los componentes electrónicos para que tuvieran pequeños contactos que les permitan adherirse directamente sobre la superficie del circuito impreso sin necesidad de realizar perforaciones. 

La tecnología SMD es muy utilizada en el campo de la electrónica, puesto que permite reducir el tamaño y peso de los elementos electrónicos. Con esta tecnología se puede realizar el control de procesos con elevados niveles de automatización, permitiendo una considerable reducción de costos e incremento de la producción. 
 
Gracias a la aparición de esta tecnología la mayoría de los diseños electrónicos son más compactos, y por esta razón el proceso de armado de placas PCB puede ser más complicado que la tecnología through hole. 

Con la tecnología de montaje superficial el costo de algunos proyectos es un poco elevado; el reducido tamaño de los componentes provoca que sea muchas veces imposible de realizar manualmente y más aún cuando dichas placas son de 2 o más capas, donde la soldadura de los elementos se hace más complicada por el poco espacio existente entre las líneas de conducción eléctrica de la placa.

Daniel Herrera, Yung Liang, 2012 realizaron una tesis de grado titulada “DISEÑO Y CONSTRUCCIÓN DE UNA MÁQUINA PARA LA ELABORACIÓN DE CIRCUITOS IMPRESOS BASADO EN CONTROL NUMÉRICO COMPUTARIZADO” en la Escuela Superior Politécnica Nacional, Quito - Ecuador, se basa en la fabricación de placas de circuito impreso para elementos tipo DIP con lo que también hace perforaciones para soldadura manual.

Este proyecto de tesis sirve de base para tener una mejor visión del control numérico computarizado aplicado a máquinas fresadoras.


FORMULACIÓN DEL PROBLEMA 


¿Cómo beneficiará la construcción de la máquina CNC al cambio de la matriz productiva, al desarrollo de nuevas tecnologías y al cuidado del medio ambiente? 
El servicio para desarrollar placas de circuito impreso para componentes SMD por medio de una máquina CNC es casi inexistente y si existe, los precios son muy elevados.

Por este motivo el mejoramiento de los sistemas electrónicos se ha quedado estancado en gran medida provocando hacer uso de tecnología extranjera y dejando a un lado el desarrollo del cambio de la matriz productiva en nuestro país. 


SISTEMATIZACIÓN DEL PROBLEMA


Obtener placas PCB con un tallado de excelente calidad, diseñando e implementando una máquina innovadora y de bajo costo.

¿Cuál es el impacto que tendría dicha máquina en el mercado nacional?
¿Qué obstáculos de implementación se podrían presentar?
¿Qué método se desarrollará para que la realización del tallado de la placa PCB sea de excelente calidad?
¿Cuáles podrían ser las limitaciones de la máquina en cuanto al tallado y funcionamiento en general?
¿Es factible realizar la máquina con las características especificadas a un precio accesible?
¿Es un proyecto amigable con el medio ambiente porque sustituye el uso de sustancias tóxicas?


JUSTIFICACIÓN 


JUSTIFICACIÓN TEÓRICA 


Las empresas e instituciones se hallan en dificultades para justificar la compra de máquinas CNC para tallar placas electrónicas que en el mercado alcanzan precios muy elevados. Realizar una máquina de características similares a las de una comercial con costos reducidos y de fácil manejo resulta beneficioso para todas las empresas dedicadas al negocio de fabricación de placas de circuito impreso.

Las instituciones educativas con carreras técnicas que están vinculadas al desarrollo de nuevos módulos que utilicen placas de buen acabado con el de objetivo mejorar la tecnología utilizada y porque no a los aficionados de la electrónica y robótica que para realizar sus proyectos necesitan gastar mucho tiempo en métodos caseros que pueden ser hasta riesgosos para la salud.

Además de lo mencionado, el tener una máquina capaz de realizar placas de circuito impreso con una precisión bastante alta, nos deja abierta la posibilidad de junto con otros proyectos poder realizar placas de diseño libre, como las muy útiles y conocidas placas Arduino, que por sus grandes funcionalidades son las más utilizadas en proyectos de electrónica y robótica que tienen que ver con microcontroladores a nivel mundial. 

El poder fabricar este tipo de placas electrónicas en nuestra institución generaría una adaptación tecnológica de lo existente en nuestro país, así como también es fortalecimiento del cambio de la matriz productiva que en este tiempo está en auge. 

La máquina en si busca facilitar el desarrollo de placas de circuito impreso para elementos de montaje superficial y normales disminuyendo el costo elevado que resultaría de enviar a hacer en otros lugares y también el tiempo que se podría invertir en otras actividades que ayudan a fortalecer los avances de tecnología en nuestro país.
JUSTIFICACIÓN APLICATIVA


Los avances tecnológicos en el campo de la microelectrónica están haciendo posible el desarrollo de CNC de una rapidez y potencia sin precedentes. 

Para el buen funcionamiento de la máquina es necesario tener una unidad de procesamiento capaz de ejecutar el código numérico con facilidad, en la actualidad el uso de Arduino y otros dispositivos como raspberry pi en la interpretación de códigos g cargando software adicional para que dichos controladores puedan ejecutar comandos numéricos, se ha hecho más que suficiente a la hora de hacer una máquina de estas características. 

Las trayectorias a seguir sin embargo deben ser puestas en marcha por motores de alta precisión ya que la confiabilidad de la máquina depende del buen movimiento mecánico que realice, para estas tareas los motores paso a paso son los indicados pudiéndose elegir por el número de pasos que tenga de acuerdo a las necesidades en el diseño de las placas de circuito impreso. 

Para que todo el funcionamiento sea posible es necesario tener un software donde se diseñará las placas PCB y será el encargado de obtener una secuencia de texto con ficheros g y m; existe software de código libre que nos ayudará a optimizar recursos conjuntamente con lo anteriormente explicado para poder hacer que la máquina tenga la precisión que se ha propuesto en este proyecto.


OBJETIVOS 


OBJETIVO GENERAL


· Diseñar e implementar una máquina CNC para la fabricación de placas de circuitos impresos para componentes SMD.  


OBJETIVOS ESPECÍFICOS 


· Investigar sobre los procesos industriales en la fabricación de placas de circuito impreso.
· Diseñar y realizar el control electrónico de los motores que gobernaran los movimientos de la máquina.
· Seleccionar el software adecuado para la traducción de los diseños de PCB a código g y m necesarios para los movimientos cartesianos de la máquina.
· Programar el código numérico para las trayectorias que debe seguir la máquina para la realización de las pistas en la PCB.
· Asegurar que la estructura mecánica junto con la programación pueda alcanzar una precisión y distancia mínima entre pistas de 200 micrones. 
· Realizar pruebas correspondientes para comprobar de que las pistas sean adecuadas para los elementos de montaje superficial. 
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CAPITULO I




[bookmark: _Toc436062963]1.                          MARCO TEÓRICO REFERENCIAL


[bookmark: _Toc436062964]1.1.                       Máquinas herramientas de control numérico computarizado 


1.1.1. [bookmark: _Toc436062965]               Introducción 


Las máquinas CNC son la evolución de lo que es fabricación en 2D, 3D, etc., siendo utilizados en diversas aplicaciones como prototipos, modelados, artesanías, etc. Estas máquinas permiten diseñar e implementar con características impresionantes de precisión y funcionales de forma económica siendo compatible con elementos y software disponibles en el mercado electrónico.

El análisis para la estructura tanto externa como interna debe ser considerado de acuerdo al tipo de producto a elaborar tanto como su funcionalidad y eficacia. Para obtener la exactitud que se desea empleamos controles especializados para lo que es la rigidez en la estructura y aspectos relevantes que se manifiesten en el diseño de nuestra máquina CNC.

Para el desplazamiento de los ejes de la máquina se debe considerar el peso su estructura y su rigidez, como parámetros fundamentales para la elección de los motores paso a paso con el torque necesario para conseguir dicho desplazamiento. Es necesario el uso de Controladores, dispuestos según el consumo máximo de corriente de los actuadores, comandados por códigos numéricos que se rigen a un protocolo de secuencia lógica que conforma un programa de maquinado.

Estos programas actualmente funcionan con lenguaje conversacional que se rige a la representación de varios códigos numéricos de tal manera que se pueda ejecutar un grupo de comandos en una sola instrucción, en algunas de ellas se puede graficar y obtener ciertas ayudas matemáticas, siendo así la programación fácil, rápida y sencilla.
1.1.2. [bookmark: _Toc436062966]               Historia del CNC (control numérico computarizado)


El control numérico computarizado o CNC, se produjo poco después de la segunda guerra mundial cuando el hombre trataba de conseguir precisión en la fabricación de piezas complejas que servían de base para la aeronáutica.

En 1801, Joseph Marie Jacquard, invento un telar mecánico que podía tejer patrones en la tela mediante el uso de tarjetas perforadas, permitiendo que personas inexpertas puedas realizar o elaborar complejos diseños de arte; esta idea se convirtió en un ejemplar para la primera máquina computacional.

En 1818, Eli Whitney construye la primera máquina fresadora, logrando incitar la fabricación de fusiles en los Estados Unidos.

En 1830, la empresa Gay & Silver revoluciono con la invención de una fresadora con regulación vertical y soporte para el husillo portafresas.

En 1848, el ingeniero Frederick. W. Howe realizó un gran aporte al desarrollo de las máquinas herramientas con el Diseñó y Fabricación de la máquina fresadora universal, siendo esta unas de las primeras en la historia que tenía añadido un dispositivo para el copiado de perfiles. 

En 1853, Brown Y Sharpe fue construida por David Brown y su hijo Jose R. Brown, es una de las máquinas herramientas de precisión más antigua y probablemente más importante de la historia, puesto que fue de gran ayuda en la fabricación y reparación de relojes y otros dispositivos mecánicos.  

En 1874, Pierre Philippe Huré diseñó una máquina herramienta fresadora de doble husillo, vertical y horizontal, dispuestos a 90° con posicionamiento controlado mediante giro manual.

En 1884, se incorporó un carnero cilíndrico posicionado axialmente en la máquina fresadora universal.  

En 1894, aparece una máquina fresadora que podía realizar varios mecanizados con diversas posiciones de la herramienta, cuya herramienta era un cabezal universal creado por el francés R. Huré y es uno de los accesorios que se utiliza en la actualidad en máquinas universales.

Con el pasar del tiempo se logró incorporar el CNC a estas máquinas herramientas más o menos tuvo su origen por los años cincuenta en el MIT (Instituto Tecnológico de Massachusetts), en donde se logró automatizar por primera vez una máquina fresadora la misma que era muy enorme debido a que en ese tiempo recién estaban saliendo las computadoras que ocupaban una habitación entera para el ordenador central.  

En la actualidad las computadoras son cada vez más compactas, eficientes y económicas, por lo cual el uso del CNC se ha abierto a todo tipo de maquinaria: tornos, rectificadoras, electroerosionadoras, máquinas de coser, taladrado, fresado, laminado o torneado, ensamblaje, trazado, oxicorte o metrología, etc.

Una máquina CNC logra controlar las trayectorias y velocidad de los motores paso a paso de los ejes logrando así movimientos tridimensionales que no se pueden conseguir con las máquinas convencionales o manuales tales como: círculos, líneas diagonales y figuras complejas en tres dimensiones.

Gracias a la aparición del control numérico computarizado se logró minimizar la mano de obra, costos y tiempo de la producción, sin necesidad que un operador este manejándola. Anteriormente los movimientos se lograban de forma manual, pero en la actualidad gracias a los nuevos sistemas CAD (Diseño asistido por computadora) y CAM (manufactura asistida por computadora) se puede generar estos movimientos de forma automática. 


1.1.3. [bookmark: _Toc436062967]             Definición del control numérico


Se define principalmente en regir posiciones de uno o diversos componentes mecánicos móviles, que constan de instrucciones relativas en desplazamientos elaborados de forma automática que parten de valores numéricos y símbolos definidos en un seudocódigo que contiene incorporado todo dispositivo electrónico.

Por lo tanto, el control numérico envía números y letras a una máquina herramienta, la misma que a través de un controlador interpreta esta serie de comandos, los convierte en pulsos eléctricos para controlar los movimientos de los ejes a través del accionamiento de los motores, con el fin de llevar a cabo el proceso mecanizado sobre la pieza de trabajo. 

1.1.3.1. [bookmark: _Toc436062968]             Elementos básicos del control numérico


Para la realización de una pieza mediante el mecanizado de una máquina herramienta se debe tener en cuenta lo siguiente:

El programa, Mediante el uso del CAD/CAM se genera una serie de líneas de códigos, donde abarca la información para el mecanizado del producto final.

El control numérico, interpreta una serie de instrucciones y a la vez las convierte en señales o pulsos eléctricos de corriente dando los respectivos movimientos a cada uno de los actuadores de la máquina.

La máquina, ejecuta los ordenamientos previstos.


1.1.3.2. [bookmark: _Toc436062969]             Aplicaciones del control numérico computarizado


El CNC es la mejor solución para todo tipo de máquinas y sectores, su alto rendimiento y precisión al momento de realizar movimientos tridimensionales para obtener un trabajo final, logran que sea una de las mayores invenciones en el campo de producción ayudando a minimizar costos de mano de obra y de fabricación, también se obtiene una mayor calidad en los trabajos finales. 

Algunas máquinas que usan sistemas de CNC son las siguientes: tornos, taladros de mesa, fresadoras, soldadoras, máquinas de corte, prensas, máquinas trazadoras, dobladoras y todas las que puedan aplicarse para modelar metales, de ebanistería, carpintería, plásticos, circuitos impresos para electrónica, etc.


1.1.3.3. [bookmark: _Toc436062970]             Ventajas del control numérico computarizado


· Capacidad de realizar diseños más complejos. Con la aplicación del control numérico computarizado en múltiples procesos ha hecho posible la fabricación de piezas complicadas mediante movimientos tridimensionales, las mismas que no eran posibles de lograr con máquinas convencionales.
· Seguridad. El control numérico computarizado es viable para trabajos altamente peligrosos evitando accidentes provocados por la intervención del hombre. 

· Precisión. Anteriormente muchos de los procesos se los realizaba con máquinas convencionales donde todo era manual, pero gracias al control numérico computarizado se logra una mayor precisión por la Generación del Código G mediante computador. 

· Aumento de productividad de las máquinas. Con la implementación de control numérico computarizado en las máquinas se logró una disminución de tiempo de trabajo, aumentando la productividad y competencia en los mercados.

· Reducción de controles de calidad y desechos. Esta reducción se logra gracias a que todo el proceso es controlado por una computadora, la misma que está programada con todo tipo de controles y prevenciones de errores durante el proceso y por ende hace uso de todo el material de producción por su alta factibilidad y repetitividad.

· Mínimas perdidas de materia prima. Con la capacidad de controlar el posicionamiento de la herramienta de trabajo se puede determinar las dimensiones del área de trabajo y por ende se puede estimar el uso de materia prima necesaria para producir una determinada cantidad de producto final.

· Mayor eficiencia en el diseño de placas PCB. se puede grabar líneas de conducción de corriente de hasta 0.2mm de precisión, logrando una reducción en los circuitos eléctricos y su vez permitiendo que los equipos sean más compactos.


1.1.3.4. [bookmark: _Toc436062971]            Desventajas del control numérico computarizado


· Alto costo de la maquinaria. Considerado que todo el proceso automático controlado por computador requiere de una electrónica altamente programada, lo mismo que genera un alto costo en la máquina según la calidad de los elementos que se utilice para su fabricación. 

· Desempleo. Por el hecho de usar CNC en una máquina no requiere de la operación de muchos trabajadores, generando desempleo y escases de trabajo.
· Capacitación del operador. Toda maquinaria requiere ser supervisada constantemente durante las actividades diarias, pero no toda persona es capaz de entender el funcionamiento de una máquina, por lo cual es necesario una capacitación del personal a cargo, esta capacitación por lo general se lo recibe en otros países representando un costo elevado para la empresa.    
 
· Eliminación de errores. El hecho de que una máquina cuente con un sistema de control no quiere decir que esté libre de errores, y por ende aún requiere de la intervención del hombre para evitar que el producto final salga defectuoso.


1.1.3.5. [bookmark: _Toc436062972]             Ámbito de aplicación del control numérico


Para poder analizar cual automatismo es más conveniente se debe tener en cuenta el número de piezas que se van a fabricar y 4 variables fundamentales: velocidad, precisión, rapidez y productividad.

Según la cantidad de piezas a fabricar se lo puede clasificar en: grandes series (cuando la producción de piezas es mayor a 10000), series medias (producción de piezas comprendidas entre 50 y 10000) y series pequeñas (producción de piezas menores a 5).

Grandes series, las máquinas transfer son las únicas que cubren este tipo de producción en la actualidad, ejecutadas por varios automatismos que trabajan de forma sincronizada simultáneamente.

Series medias, los copiadores y los controles numéricos son un buen ejemplo de automatismos que cubren esta gama, donde su utilización dependerá de la precisión, flexibilidad y rapidez exigida. El control numérico es interesante puesto que puede lograr series repetidas entre 5 y 10000 piezas durante el año.

Series pequeñas, el uso del control numérico no resulta muy rentable para esta gama, a menos que la fabricación de la pieza sea muy compleja. Pero para este tipo de series resulta más económico el mecanizado de máquinas convencionales.  
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[bookmark: _Toc436144937]                           Figura 1‑1. Ámbito de aplicación del control numérico.  
                                     Fuente: http://es.slideshare.net/sergioringler1/control-numrico-51512906


1.1.4. [bookmark: _Toc436062973]             Comparación de utilización entre máquinas convencionales y CNC   	


[bookmark: _Toc436145045] Tabla 1‑1. Comparación entre máquinas convencionales y máquinas CNC.

Fuente: http://www.marcombo.com/Descargas/LIBRO.pdf 
Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015


1.1.5. [bookmark: _Toc436062974]             Fresadora    


Las máquinas fresadoras han tenido un exponencial aporte en el desarrollo industrial, con la automatización de las máquinas herramientas. Estas máquinas son muy similares a las convencionales, con las mismas partes móviles mesa, cabezal de corte, husillo y carros de desplazamiento lateral y transversal, con la diferencia de que no poseen manivelas para el accionamiento de estas partes móviles.

Las máquinas herramientas fresadoras de la actualidad poseen un panel donde se encuentran todos los accionamientos de control y una caja metálica donde está todo el sistema eléctrico y electrónico necesario para conseguir el accionamiento de dichas partes móviles que antes lo hacían por manivelas.

El CNC, no es más que una computadora responsable de todos los movimientos que se lleven a cabo en la máquina fresadora, lo mismos que se consiguen con una serie de comandos, que son interpretados por un controlador para convertirlos en pulsos de corriente y voltaje, con los cuales se logra los movimientos de los motores o servomotores acoplados en cada uno de los ejes de la máquina.   
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[bookmark: _Toc436144938]                              Figura 2-1. Fresadora para el tallado de placas PCB.  
                                         Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


1.1.6. [bookmark: _Toc436062975]             Ejes de la máquina fresadora    


Las MHCN disponen de diferentes órganos de movimiento lineal (generalmente ejes), para poder programar el movimiento de dichos elementos se les asigna una letra, que será la que después se utilizará en la programación. Esta asignación de letra está normalizada y no puede ser cambiada en ningún caso. Los signos “+” y “-” no tienen un sentido matemático sino de dirección (Teruel, 2004, pp. 1-3).
En las máquinas CNC fresadoras para el tallado de placas PCB, la pieza o material a trabajar se ubica en la base de la misma, donde con los movimientos en los ejes: X, Y e Z se logra el tallado deseado.

Transversal, conocido como eje “X”, se encuentra horizontal y paralelamente a la base de sujeción de la pieza. Se desplaza en forma transversal a la máquina.

Longitudinal, conocido como eje “Y”, se encuentra vertical y paralelo a la base de sujeción de la pieza. Su desplazamiento lo realiza a lo largo de la máquina.

Vertical, conocido como eje “Z”, es la parte donde va montado el husillo, los tres desplazamientos que realiza son controlados por el cabezal. Posee la potencia para desplazar la herramienta verticalmente dando la profundidad de corte.
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[bookmark: _Toc436144939]                                          Figura 3-1. Desplazamiento de los ejes 
                                                              de la fresadora.  
                                          	    Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


1.1.7. [bookmark: _Toc436062976]             Cinemática de la fresadora    


La cadena cinemática de la fresadora estudia los movimientos de ésta y se distinguen dos tipos (Gómez, 2012, pp. 250-294).
Movimiento de rotación. - El movimiento de rotación se le da al eje principal de la máquina, como las herramientas van caladas en este eje, son las revoluciones a las que podemos hacerlas girar. La máquina lleva una caja de cambios con una gama de velocidades no muy alta, generalmente comprendida entre 50 y 150 rpm (Gómez, 2012, pp. 250-294).
 
Movimiento de traslación. - Son los movimientos de los carros de la máquina, comprende los motores que generan dicho movimiento para trabajar con avances automáticos. Incorpora una caja con estos avances, los cuales podemos seleccionar por medio del cambio manual (Gómez, 2012, pp. 250-294). 

Caja de cambios. - Llamada también caja de velocidades. Es la caja que contiene los trenes de engranajes y haciendo ensamblar unos con otros, se consiguen las distintas revoluciones a dar al eje de la máquina, esta lleva la herramienta con la cual se está trabajando. El cambio de revoluciones se realiza mediante palancas (Gómez, 2012, pp. 250-294).

Caja de avances. - Es la caja de cambios donde se seleccionan los distintos avances de los carros con el fin de desplazarlos de forma automática, consiguiendo así las velocidades de corte adecuadas al material a trabajar. Es una de las partes más importantes de la máquina, pues cuanto más amplia sea la gama de velocidades podremos ajustar mejor la velocidad de corte (Gómez, 2012, pp. 250-294). 


1.1.8. [bookmark: _Toc436062977]             Tipos de fresadoras


En esta clasificación se mencionará solo las más importantes y comúnmente usadas en la industria.

· Fresadoras horizontales

Realiza trabajos de desbaste o acabado en línea recta generando listones o escalones esto se logra gracias a que la fresa se coloca sobre un eje horizontal que se ubica en el husillo principal.

La limitación de esta máquina es la profundidad a la que puede trabajar, ya que esta dependerá de la distancia de la herramienta al eje de la máquina. 

[image: https://pyrosisproyect.files.wordpress.com/2011/09/fresadora-horizontal-kearney-trecker-300x224.jpg]








[bookmark: _Toc436144940]                                    Figura 4-1. Fresadora horizontal.    
                                                  Fuente: https://pyrosisproyect.files.wordpress.com

· Fresadoras verticales

Este tipo de fresadoras tienen su eje orientado verticalmente y perpendicular a la mesa. Tienen la posibilidad de realizar pequeños desplazamientos axiales, los mismos que resultan convenientes para realizar un labrado escalonado o en escalada.

Este tipo de máquinas también resultan convenientes para el taladrado de agujeros a distancias medidas o precisas.

La limitación de esta máquina es la fuerza perpendicular a la que se puede someter la fresa por la mesa de trabajo, para lograr el avance.

[image: D:\Cristian\TESIS\fresadora vertical.png]
[bookmark: _Toc436144941]                                               Figura 5-1. Fresadora vertical  
                                                                 Fuente: http://biblio3.url.edu.gt/Libros/2013/pro_ma/11.pdf
· Fresadoras universales

Este tipo de máquinas son similares a las fresadoras simples; las fresadoras universales se diferencias de las demás máquinas por el giro del carro en torno al eje vertical y la fresa va en sentido horizontal, en el husillo. Es decir, resulta de la combinación de una fresa vertical y una horizontal.

Su limitación es el costo y el tamaño de las piezas que se pueden trabajar, por ser sus guías muy cortas no resultan óptimas para la realización de trabajos pesados, las mismas que fueron diseñadas de esta forma para permitir el giro de la máquina al realizar trabajos, sin rozar el cuerpo del operario.

[image: D:\Cristian\TESIS\fresadora universal.png] 

                            	










[bookmark: _Toc436144942]                       Figura 6-1. Fresadora universal.
                               Fuente: http://biblio3.url.edu.gt/Libros/2013/pro_ma/11.pdf
                     
· Fresadoras especiales

Este tipo de fresadoras de las denomina especiales por poseer características únicas sobre las demás máquinas; entre ellas, las formas constructivas varían en gran proporción. Esto se ocasiona por las características de los diversos trabajos de fabricación para los que han sido establecidos.

Dentro de este grupo podemos nombrar las siguientes fresadoras especiales: la fresadora paralela, se usa en trabajos de material pesado, la fresadora de planear destinada para trabajos en cadena y las máquinas de fresar roscas, como su nombre lo indica se dedican al fresado de roscas. 
[image: ]
[bookmark: _Toc436144943]           Figura 7-1. Máquinas fresadoras: vertical (izq.), 
                               paralelo (centro), planear
                                                   Fuente: Heinrich Gerling, Alrededor de las máquinas herramientas  

· Fresadora CNC

Una fresadora CNC es una máquina herramienta controlado por medio de una serie de comandos o programa que utiliza números, letras y otros símbolos; están programados en un código determinado que permite definir un programa de instrucciones que realiza una tarea específica, también se utiliza programas CAD/CAM. Todo esto es enviado atreves de un ordenador hacia la caja de control de la MHCNC.

[image: https://fbcdn-sphotos-d-a.akamaihd.net/hphotos-ak-xap1/v/t34.0-12/12092609_956342074430986_450160793_n.jpg?oh=a2b54f05f40e4b5830715eea8769c50b&oe=561D9180&__gda__=1444755610_dbd0eab78e16281286f5a5baa38799a7]                                            










[bookmark: _Toc436144944]	                                     Figura 8-1. Máquina Fresadora CNC.
                                                   Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015



1.1.9. [bookmark: _Toc436062978]             Partes mecánicas

[image: ]
[bookmark: _Toc436144945]                	              Figura 9-1. Partes principales de una fresadora.
                                                       Fuente: Fresadora, Ing. Guillermo Bavaresco  

1. Base, permite que la máquina fresadora tenga apoyo correcto sobre la superficie que este ubicada.

2. Columna, también denominado como cuerpo o bastidor, se apoya sobre la base o a la vez están unidos formando una sola estructura y sirve como soporte para la mesa y el cabezal.

3. Consola, se desplaza en forma vertical sobre las guías de la estructura y a la vez sirve de soporte para la mesa de trabajo. 

4. Carro transversal, se sujeta y desplaza horizontalmente por las guías de la consola, por lo tanto, puede realizar movimientos transversales con la mesa de trabajo sujeta al carro.

5. Mesa, es una superficie plana con hendiduras donde se coloca el material a maquinar, su desplazamiento se logra a través de dos carros ubicados: longitudinal y transversalmente sobre los cuales va sujeta.

6. Puente, va sujeta sobre el bastidor, donde a su vez se apoya el eje porta fresas. Para facilitar el desplazamiento de toda la máquina, se usa uno o varios tornillos en la parte superior del puente, por lo general estos tornillos son de cáncamo.

7. Husillo, también conocido como portaherramientas o porta fresas, es la parte donde se montan las herramientas de cortes, acompañado por una rotación generado por un motor DC.     


1.1.10. [bookmark: _Toc436062979]             Tipos básicos de fresado


Existen dos tipos básicos de fresado:


1.1.10.1. [bookmark: _Toc436062980]Fresado en las caras o frontal


Este tipo de fresado se lleva acabo ubicando el eje del porta fresas de forma perpendicular a la mesa de trabajo, donde el maquinado se lo realiza por las bordes de los extremos de la pieza y el contorno de la fresa.

[image: D:\Cristian\TESIS\fresado frontal.png]  





                             
[bookmark: _Toc436144946]                          Figura 10-1. Fresado frontal.
                                    Fuente: http://wikifab.dimf.etsii.upm.es/wikifab/images/8/85/Fresado.pdf

Tipos de fresado frontal

· Fresado convencional

Este tipo de fresado solo ocurre cuando las dimensiones de la fresa resultan ser más grandes que las establecidas para el área de fresado.

[image: D:\Cristian\TESIS\fresado convencional.png]
[bookmark: _Toc436144947]                                                              Figura 11-1. Fresado 
                                                                             convencional.
               Fuente: http://es.slideshare.net

· Fresado parcial de caras

Este tipo de fresado solo ocurre cuando la fresa excede el área de fresado en un extremo.

[image: D:\Cristian\TESIS\fresado parcial de caras.png]
[bookmark: _Toc436144948]                                                            Figura 12-1. Fresado 
                                                                      parcial de caras
            Fuente: http://es.slideshare.net

· Fresado terminal

Este tipo de fresado se da cuando las dimensiones de la fresa son menores que las dimensiones del área de fresado, por lo tanto, solo corta una pequeña hendidura en el material a maquinar.

[image: D:\Cristian\TESIS\fresado terminal.png]
[bookmark: _Toc436144949]                                                         Figura 13-1. Fresado 
                                                                               terminal.
        Fuente: http://es.slideshare.net
 
· Fresado de perfiles

Este tipo de fresado consiste en cortar un segmento plano del borde de una pieza o material a maquinar, es un modo de fresado terminal. 

[image: D:\Cristian\TESIS\fresador de perfiles.png]
[bookmark: _Toc436144950]                                                          Figura 14-1. Fresado de 
                                                                                perfiles.
         Fuente: http://es.slideshare.net

· Fresado de cavidades

Es otra forma de fresado terminal usada para fresar cavidades poro profundas en partes planas.

[image: D:\Cristian\TESIS\fresado por cavidades.png]
[bookmark: _Toc436144951]                                                         Figura 15-1. Fresado por 
                                                                               cavidades.
        Fuente: http://es.slideshare.net

· Fresado de contorno de superficies

Este tipo de fresado se lo lleva acabo con una fresa de perfil esférico y no con una cuadrada, la cual de desplaza para delante, para atrás, a un lado u otro en el área de fresado, logrando con pequeños intervalos de desplazamiento un movimiento curvilíneo para la elaboración de piezas en tres dimensiones. 

[image: D:\Cristian\TESIS\fresado contorno de superficies.png]
[bookmark: _Toc436144952]                                                         Figura 16-1. Fresado de 
                                                            contorno de superficies.
        Fuente: http://es.slideshare.net


[bookmark: _Toc436062981]1.1.10.2.	Fresado periférico o cilíndrico


En este tipo de fresado el porta fresas está ubicado paralelamente al área de fresado y la ejecución del maquinado lo efectúa alrededor del contorno externo de la fresa.

[image: D:\Cristian\TESIS\Fresado cilindrico.png]
[bookmark: _Toc436144953]                                 Figura 17-1. Fresado cilíndrico.
                                             Fuente: http://wikifab.dimf.etsii.upm.es/wikifab/images/8/85/Fresado.pdf

Tipos de fresado cilíndrico

[image: D:\Cristian\TESIS\fresado concordancia.png]
[bookmark: _Toc436144954]                                Figura 18-1. Fresado en oposición y concordancia.  
                                            Fuente: http://es.slideshare.net/nurrego/fresado

En el fresado cilíndrico la fresa tiene dos sentidos de rotación, las mismas que puede tomar según la actividad o maquinado que va a realizar. Estos sentidos diferencian dos tipos de fresado:

· Fresado en oposición o normal

A este tipo de fresado también se lo conoce como convencional y se da cuando los dientes de la fresa rotan en sentido opuesto al avance sobre el área de maquinado, logrando de esta forma la extracción de viruta.

· Fresado en concordancia

Este fresado es opuesto a fresado normal porque el sentido de rotación de los dientes de la fresa va en la misma dirección de avance sobre el área de maquinado, durante la extracción de viruta. También hay otros tipos de fresado cilíndrico y son los siguientes:

· Fresado de placa

Es la forma básica de fresado cilíndrico en la cual el ancho de la fresa se extiende más allá de la pieza de trabajo en ambos lados. 

[image: D:\Cristian\TESIS\fresado de placa.png]
[bookmark: _Toc436144955]			                    Figura 19-1. Fresado de 
                                                                                 placa.  
			          Fuente: http://es.slideshare.net

· Ranurado

En este tipo de fresado las dimensiones de la fresa son menores que las dimensiones del área de trabajo, creando una hendidura en la pieza trabajo. Si la fresa es delgada, por lo general se la utiliza para cortar en dos partes una pieza, a esto se conoce como fresado aserrado.

[image: D:\Cristian\TESIS\ranurado.png]
[bookmark: _Toc436144956]				        Figura 20-1. Ranurado.
			           Fuente: http://es.slideshare.net

· Fresado lateral

En este caso la fresa realiza el maquinado a un lado de la pieza de trabajo.

[image: D:\Cristian\TESIS\fresador lateral.png]
[bookmark: _Toc436144957]    Figura 21-1. Fresado lateral.
			      Fuente: http://es.slideshare.net

· Fresado paralelo simultaneo

Este trabaja al igual que el fresado lateral, con la diferencia que este posee dos fresas en sus extremos que realizan los cortes laterales en el material de trabajo.

[image: D:\Cristian\TESIS\fresado paralelo simultaneo.png]
[bookmark: _Toc436144958]  Figura 22-1. Fresado paralelo 
                        simultaneo.   
			   Fuente: http://es.slideshare.net




1.1.11. [bookmark: _Toc436062982]             Fresas


Las fresas son herramientas de corte o grabado que generalmente y constituyen las herramientas principales en máquinas fresadoras y pantógrafos. Estas fresas se asemejan a las brocas empleadas en taladros.

Hay diferentes tipos de fresas que varían según la aplicación o uso que se les vaya a dar. Una fresa viene determinada por el número de labios que tenga, diámetro de caña, forma, profundidad de corte y el material constituyente. Dichos labios pueden ser rectilíneos o helicoidales.


1.1.11.1. [bookmark: _Toc436062983]Características de las fresas


Las fresas generalmente son construidas en acero rápido, pero por el elevado costo del material, las fresas más grandes poseen un cuerpo de acero y en la parte cortante se acoplan cuchillas (o dientes) de acero rápido o a su vez insertos de corte (widia), estos pueden ser permanentes o intercambiables.

Las cuchillas que van alrededor del eje son muy filosas y están destinadas a eliminar el material de la pieza a maquinar (materia prima) transformándola en una pieza acabada (producto final), con las dimensiones y formas deseadas.


1.1.11.2. [bookmark: _Toc436062984] Tipos de fresas


Según la actividad que va a realizar una máquina fresadora existen un sinfín de fresas que son empleadas para trabajar distintos materiales como el metal, la madera y plásticos. Debido al gran número de fresas se detalla una tabla, donde contiene la clasificación de las fresas, así como como su esquema, aplicaciones, características y algunos ejemplos.




	
[bookmark: _Toc436145046]Tabla 2-1. Uso y selección de fresas.
	TIPOS FRESAS
	CARACTERÍSTICAS
	APLICACIONES
	ESQUEMA
	EJEMPLOS

	







CILÍNDRICAS PERIFÉRICAS (dientes solo en la periferia)
	
Con dentado recto
(corte brusco)
	

Uso en la fresadora horizontal 

· Planeado
· Desbaste
· Afinado

	[image: D:\Cristian\TESIS\imagen de fresa1.png]
	





Fresado en superficies planas
· Superficies de apoyo de materiales
· Superficie de deslizamiento para rieles
· Superficie de guías, correderas, etc.

	
	
Con dentado helicoidal
El espaciado entre dientes varía según la dureza del material a fresar (Blando = mayor espaciado, Duro = menor espaciado)

	
	[image: D:\Cristian\TESIS\imagen de fresa2.png]
	

	
	
Acopladas
Montaje de dos fresas con dentado helicoidal de sentido opuesto (permite el equilibrio de las fuerzas axiales)

	
· Desbaste
· Rebajado de superficies
· Ranurado profundo

	[image: D:\Cristian\TESIS\imagen de fresa3.png]
	

	CILÍNDRICAS FRONTALES SIN VÁSTAGO
(dientes en la periferia y cara lateral)
	
	Uso en la fresadora horizontal y vertical para fresado en escuadra
· Rebajado en ángulo recto
	[image: D:\Cristian\TESIS\imagen de fresa4.png]
	

	



DE DISCO
(poca longitud de corte a su diámetro)
	
Con dentado recto
	
· Ranurado plano
	[image: D:\Cristian\TESIS\imagen de fresa5.png]
	
· fresado de tornillos
· fresado de chaveteros planos y profundos
· curvas
· arcos circulares


	
	
Con dentado cruzado o alterado
	
· Ranurado profundo 
	[image: D:\Cristian\TESIS\imagen de fresa6.png]
	

	
	
Con dentado en cruz
	
· Chaveteros profundos
	[image: D:\Cristian\TESIS\imagen de fresa7.png]
	

	CONTINUACIÓN 

	
	
Acopladas ajustables
Montaje de dos fresas de disco, rectas o en cruz, una sobre otra;
	
· Ranurado profundo con longitudes ajustables
	[image: D:\Cristian\TESIS\imagen de fresa8.png]
	

	
	


Sierras circulares
	
· Corte de piezas 
· Ranurado estrecho (Cabezas de tornillos)
	[image: D:\Cristian\TESIS\imagen de fresa9.png]
	

	



ANGULARES SIN VÁSTAGO
(Dos filos principales que forman un ángulo entre sí)
	

Frontales
	
· Mecanizado de guías en ángulo a 45,40,55 y 60 grados 

	[image: D:\Cristian\TESIS\imagen de fresa10.png]
	

Obtención de
· Guías prismáticas en ángulo
· Reglas de acero para taller de 3 y 4 aristas, con sección rectangular


	
	


Prismáticas
	
· Mecanizado de guías prismáticas en ángulo de 45, 60 y 90 grados

	[image: D:\Cristian\TESIS\imagen de fresa11.png]
	

	





FRESAS CON VÁSTAGO
(cilíndrico o cónico) 
	







Cilíndrico - frontales
	
De bola o punta esférica
	
· Copiado 
· Matrices
· Fresado de contornos
· Acabado
· Desbaste


	[image: D:\Cristian\TESIS\imagen de fresa12.png]
	
Fresas de
· Piezas hexagonales
· Chaveteros y orificios rasgados
· Tuercas
· Ejes de chavetas
· Ruedas dentadas

	
	
	
De punta plana
	
	[image: D:\Cristian\TESIS\imagen de fresa13.png]
	

	
	
	
Para ranuras T
	

· Ranurado
	[image: D:\Cristian\TESIS\imagen de fresa14.png]
	

	
	
	Para ranuras Woodruff
	
	[image: D:\Cristian\TESIS\imagen de fresa15.png]
	

	CONTINUACIÓN 

	
	
Crónicas
	· Avellanado preciso de orificios 
	[image: D:\Cristian\TESIS\imagen de fresa16.png]
	

	
	

Angulares 
	Cola de milano
(Forma trapezoidal)
	· Ranurado y ensamble de cola de milano
	[image: D:\Cristian\TESIS\imagen de fresa17.png]
	

	








DE PERFIL CONSTANTE
(con o sin vástago) dejan la geometría del diente en la pieza a mecanizar  
	






Destalonadas
	


Convexas
	
· Ranurado semicircular con radios de 1 a 20 mm

	[image: D:\Cristian\TESIS\imagen de fresa18.png]
	











Fresado de
· Superficies sinuosas
· Curvas
· Arcos
· Ranuras
· Perfiles de todo tipo


	
	
	



Cóncavas 
	
· Obtención de superficies semicirculares con radios de 0.5 a 20 mm

	[image: D:\Cristian\TESIS\imagen de fresa19.png]
	

	
	





De módulo
(Fresas de disco) 
	

Tallado de 
· Engranajes
· Ruedas dentales
· Piñones de cadena
· Cremalleras
· Tornillos sin fin

	[image: D:\Cristian\TESIS\imagen de fresa20.png]
	

	
	

Múltiples 
	
· Roscado
· Mordazas 

	[image: D:\Cristian\TESIS\imagen de fresa21.png]
	

	CONTINUACIÓN 

	
Compuestas
(Tren de Fresas)
	
Montaje de dos o más fresas de distinto tipo (reúnen las propiedades de las fresas de perfil constante a un costo mucho menor)

	[image: D:\Cristian\TESIS\imagen de fresa22.png]
	
Fresado de perfiles de todo tipo

	

FRESAS MADRE
(Con o sin vástago)
	

Mecanizan al mismo tiempo todos los dientes de un engranaje, con una gran ventaja sobre las fresas de módulo, que lo hace diente por diente  
	

Ídem fresas de módulo 
	[image: D:\Cristian\TESIS\imagen de fresa23.png]
	Fresado por generación
· Obtención de engranajes en serie con el numero deseado de dientes, perfiles y ángulos de hélice


Fuente: (DE MÁQUINAS Y HERRAMIENTAS, 2012)
Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015

Existen muchísimos tipos de fresas especialmente para trabajar en placas PCB, según su forma y su tamaño.

[bookmark: _Toc436145047]Tabla 3-1. Especificaciones de las herramientas para CNC.
	Tipo
	Diámetro vástago
	Angulo
	Diámetro de punta
	Longitud
	Material
	Fotografía

	Fresa en V
	3.17mm
	20°
	0.1mm
	33mm
	Carburo
	[image: D:\Cristian\TESIS\fresa1.png]




	Fresa en V 
	3.17mm
	10°
	0.1mm
	33mm
	Carburo 
	[image: D:\Cristian\TESIS\fresa2.png]




	Broca
	3.17mm
	-
	0.4mm
	33mm
	Carburo
	[image: D:\Cristian\TESIS\fresa3.png]




	CONTINUACION 

	Broca
	3.17mm
	-
	0.8mm
	33mm
	Carburo
	[image: D:\Cristian\TESIS\fresa4.png]




	Broca
	3.17mm
	-
	1mm
	33mm
	Carburo
	[image: D:\Cristian\TESIS\fresa5.png]





	Fresa en V
	3.17mm
	30°
	0.1mm
	33mm
	Carburo
	[image: D:\Cristian\TESIS\fresa6.png]





	Fresa en V
	3.17mm
	60°
	0.2mm
	33mm
	Carburo
	


Fuente: Ing. Pedro Espín. 
Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015


1.1.11.3. [bookmark: _Toc436062985]  Operaciones de fresado


En todas las máquinas fresadoras del tipo MH, se puede realizar una variedad de fresados, a continuación, se muestra los diferentes de tipos de operaciones que se pueden tener:

· Planeado, el objetivo de esta operación se centra en la consecución de una superficie completamente plana, utilizándose para ello platos de fresar. Mediante el planeado se consigue eliminar la parte superior de la pieza, obteniendo un plano totalmente horizontal.

· Corte, esta operación tiene como objeto que ya sea al final o al comienza del mecanizado de una pieza, realiza un corte con las dimensiones establecidas por el usuario. Por lo general en máquinas CNC para la fabricación de placas PCB se realiza el final del fresado.

· Ranurado recto, para conseguir este fresado de ranuras rectas es necesaria la utilización de fresas cilíndricas con el ancho de la ranura y, de vez en cuando, se acoplan varias fresas a la porta herramientas permitiendo aumentar la productividad de mecanizado.

· Fresado de cavidades o cajeras, para conseguir este fresado primero se debe hacer un agujero por donde va a entrar la fresa o inicia el fresado, también se puede utilizar fresas con posibilidad de lograr rampas de penetración. Una vez elegida la fresa comienza el mecanizado, que consiste en vaciar un volumen interior que por lo general tiene forma de caja, de ahí su nombre, aunque puede tener cualquier forma.

· Fresado en rampa y el taladrado, para este tipo de fresado es recomendable la utilización de máquinas fresadoras CNC, por su amplia gama de intercambiar fresas.

Como este tipo de operaciones se requiere de precisión y eficiencia, es necesario el uso de parámetros de mecanizado, para la lograr obtener un producto de mayor calidad.


1.2. [bookmark: _Toc436062986]                Software CAD/CAM 


1.2.1. [bookmark: _Toc436062987]             Software CAD (diseño asistido por computadora)


Los programas para diseño de placas electrónicas PCB más utilizados en este proyecto son: Proteus, Eagle, Multisim con los cuales estamos muy familiarizados, además de ser muy completos; brindándonos la posibilidad de generar archivos gerber para poder enviarlos a un software CAM en el siguiente paso, existen muchos más softwares que pueden utilizarse dependiendo del conocimiento y la necesidad.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\labcenter-proteus.master.jpg]               [image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\eagle.jpg]
[bookmark: _Toc436144959]Figura 23-1. Programas para diseños virtuales.
Fuente: http://www.software.com.ar/p/labcenter-proteus-2196


1.2.2. [bookmark: _Toc436062988]             Software CAM (manufactura asistida por computadora)


El software CAM es el que sirve de puente entre el CAD (Diseño Asistido por Computadora) y el lenguaje de programación de las máquinas herramienta. En nuestro caso este software se encarga de generar código G a través de los archivos gerber creados anteriormente. Existe una gran variedad de software CAM tanto de código libre como propietarios, el objetivo de este trabajo final de grado es usar código libre como manera de apoyar al desarrollo de nuevas tecnologías con open-source.

El software elegido tanto por su gran capacidad como por su interfaz amigable con el usuario es FLATCAM, donde se configura principalmente la velocidad de fabricación de las PCB, dimensiones de herramienta, calibración de la máquina, entre otras.


1.2.2.1.1. [bookmark: _Toc436062989]          FlatCam


[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\flatcam.png]
[bookmark: _Toc436144960]                        Figura 24-1. Entorno grafico de FlatCam.    
                                 Fuente: http://flatcam.org/tutorial/selective_p2

Flatcam es un software de código abierto desarrollado en Python que puede ser ejecutado en la mayoría de plataformas sin ningún problema.

Flatcam permite llevar nuestros diseños a un router CNC, es capaz de abrir archivos gerber, excellon, hasta un mismo código-g para tener una salida de este mismo de acuerdo a nuestras necesidades.
1.2.2.2. [bookmark: _Toc436062990]             GRBL: software de control numérico computarizado


Acerca del software:

 GRBL está bajo la Licencia Pública General GNU y ha sido desarrollado por el programador Simen Svale Skogsrud en Noruega. Las actualizaciones de este programa para cargar en Arduino pueden descargarse desde el repositorio de GRBL (Peters, 2015). 

GRBL es un software escrito en C optimizado de código abierto que se ejecuta en la plataforma Arduino.

Es ideal para usuarios que realizan trabajos de fresado y que necesitan de un controlador amigable manejado desde una interfaz gráfica de usuario.

Características:

GRBL se diseñó para producción en poca potencia. Podemos usarlo para todo nuestro fresado, ejecutándolo desde nuestras computadoras portátiles utilizando un GUI de usuario de acuerdo a nuestra necesidad para transmitir el código G hacia la máquina. Está escrito en C optimizado que utiliza muchas características inteligentes de los chips ATmega328P de Arduino para lograr una alta sincronización con los movimientos asincrónicos de los ejes de la máquina. 

Tiene la capacidad de mantener una frecuencia de pasos de más de 30 kHz, GRBL está dedicado para máquinas CNC de tres ejes X, Y e Z. El firmware intérprete de código G está equipado con un conjunto de la norma rs274/ngc NIST y ha sido probado con archivos de código-g de un gran número de Herramientas CAM sin problemas. Los movimientos lineales, circulares y helicoidales son compatibles.

Características de GRBL V0.8:

La versión V0.8 de GRBL no es la última que está disponible para descargar, existe la V0.9 que incluye muchas configuraciones que no son necesarias para el buen funcionamiento de la máquina CNC por lo que se ha utilizado la versión V0.8. Aquí algunas de las características más importantes de esta versión:

Comandos multi-tarea en tiempo de ejecución del código-g: 
Puede hacer una pausa en el programa (Feed Hold) con una desaceleración capaz de controlar para no perder la ubicación con la posibilidad de una reanudación.

Advanced Cycle Homing: 

Una gran gama de opciones de configuración para los diferentes tipos de máquinas; cómo deben moverse los ejes en busca de direcciones. Los interruptores (finales de carrera) se pueden usar también como Hard limit. 

Datos de sistema de coordenadas persistente: 

Coordenadas de trabajo (G54-G59) y de posiciones preestablecidas (G28, G30) se almacenan en la memoria EEPROM, por lo que no se van a borrar al desconectar el Arduino UNO y estarán configuradas como la última vez.

Comprobación modo de código G:

Configura GRBL para ejecutar los programas sin mover nada en la máquina, así se puede comprobar si existen errores en GRBL que no nos gusten.

Mejora de retroalimentación: 

Posición en tiempo real, qué está haciendo GRBL, también en qué estado se encuentra el analizador de código g, y los valores de coordenadas de los offset almacenados.

Bloques de inicio: 

Se puede ejecutar bloques de código G en el inicio o reinicio del programa.
Pin-outs: Cycle start, Feed Hold, y abort están conectados en los pines analógicos del Arduino UNO A0, A1, A2. Sólo se tiene que conectar un interruptor (final de carrera) normalmente abierto al pin que corresponda y a tierra.

Interfaz gráfica de usuario para GRBL.

GRBL permite usar el software Arduino para poder comunicarse, sin embargo, se recomienda usar un GUI para transmitir el código-g a GRBL. 

[image: ]
[bookmark: _Toc436144961]            Figura 25-1. Interfaz gráfica GRBL (Gcode Sender).     
                 Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Universal Gcode Sender es una interfaz gráfica de usuario que tiene todas las funciones creadas por el desarrollador estadounidense Will Winder, posee un visualizador de código-g y tiene un completo control de las características de GRBL, está escrito en Java, esto significa que puede ser ejecutado en cualquier máquina con Java incluido la Raspberry Pi.

Los desarrolladores de GRBL recomiendan usar esta interfaz ya que si se tiene alguna recomendación o alguna falla solo basta con hacer una petición en la Wiki de GRBL. Igualmente, si se necesita una versión anterior o compatible con otro sistema operativo del GUI se puede descargar de la wiki de Will Winder (desarrollador).

[image: ]
[bookmark: _Toc436144962]                        		   Figura 26-1. Simulación grafica del maquinado en PCB.
                                 		    Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
CONFIGURACIÓN DE GRBL V0.8 PARA UNA MÁQUINA CNC

NOTA: La siguiente documentación de este software ha sido traducida al español por el proyecto DIYLILCNC desde la página del desarrollador (Simen Svale Skogsrud en Noruega). GRBL tiene Licencia Pública General GNU.

GRBL tiene un sistema de comandos ‘$’ que se usan para la configuración de los parámetros que intervienen en la puesta en funcionamiento de la máquina. Podemos conectarnos a GRBL usando un cable serial (USB) a una velocidad de transmisión 9600 Baudios, velocidad que usa el firmware GRBL v0.8.

Comandos de configuración: “$$”, $X=val, $N y $NX=line

$$ (ver la configuración actual de GRBL) y $X = val (guardar configuración necesaria en GRBL)

Cuando se conecta a GRBL se debe escribir en la ventana de comandos $$ y presionar ENTER, GRBL responderá con una lista de los valores actuales del sistema como se muestra en la siguiente lista. Todos estos valores son guardados en la memoria EEPROM lo que significa que si se apaga el equipo, en la próxima vez que se encienda estos valores se cargaran automáticamente.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\ConfigActualGRBL2.jpg]
[bookmark: _Toc436144963]Figura 27-1. Configuración GRBL, parte 1.    
Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\ConfigActualGRBL2.jpg]
[bookmark: _Toc436144964]Figura 28-1. Configuración GRBL, parte 2.    
Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Para cambiar, por ejemplo, la opción de pulsos número 3 a 10us se debe escribir lo siguiente y presionar ENTER.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\Pulsopaso10us.jpg]
[bookmark: _Toc436144965]Figura 29-1. Configuración GRBL.    
Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Si la operación fue correcta GRBL siempre responde con un “OK”, para verificar el cambio de la configuración se puede escribir en la ventana de comandos “$$” y se desplegara la lista anterior con el valor actualizado.

$N (ver bloques de inicio) y $NX=line (guardar el bloque de inicio)

$Nx: son los bloques de inicialización que se ejecutan cuando de enciende o se resetea GRBL.
De otra manera, un bloque de inicialización es una porción de "código g" que puede estar ejecutándose automáticamente para poder seleccionar valores de código g predeterminados, o cualquier cosa que se necesita que haga GRBL cada vez que arranque el equipo.

Por el momento, GRBL puede almacenar dos bloques de código-g por defecto en el sistema. Cuando se conecte a GRBL, escriba $ y luego presione ENTER y GRBL debe responder con un mensaje, como:

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\MensajeCorto.jpg]
[bookmark: _Toc436144966]Figura 30-1. Configuración bloques de inicio. 
Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

De GRBL $x = valor, configuración y su significado

$0, $1 y $2 (pasos/mm de ejes X, Y y Z)

GRBL necesita conocer que distancia desplazará cada paso la herramienta en la realidad. Para calcular los pasos/mm para cada eje se debe conocer los siguientes parámetros:

-Los mm por revolución del tornillo de avance
-Los pasos completos por revolución de los motores paso a paso (normalmente 200)
-Los micros pasos por paso de su driver (normalmente 1, 2, 4, 8 o 16).



Este valor se debe calcular para los tres ejes y modificarlos en la configuración.

$3 (Pulsos de paso, microsegundos)

En este ítem hay que revisar la hoja de datos de los motores o simplemente probar algunos números. Si los pulsos del motor son demasiado largos podría darse problemas en la ejecución a altas velocidades de avance. Generalmente entre 5 y 50 microsegundos funciona bien (Peters, 2015).

$4 y $5 (Feed Rate y seek Rate por defecto, mm/min)

Esta configuración cambia el seek rate por defecto (G0) y el feed rate (tasa de alimentación) (G1, G2, G3) después de inicializar GRBL. El seek rate (conocido como saltos rápidos) es utilizado para moverse desde un punto A hasta un punto B lo más rápido posible, por lo general para el desplazamiento a la posición inicialización de un ciclo. El seek rate se debe ajustar a la máxima velocidad a la que la máquina puede ir en los movimientos de cualquier eje (Peters, 2015). 
$6 (Invertir los puertos de entrada de paso por máscara de bits, int: binaria)

Algunos controladores para CNC necesitan que sus entradas de nivel alto y bajo estén invertidas tanto para la dirección como para los pasos. GRBL puede invertir los bits de salida para acomodarse a nuestras necesidades. El valor invertido de la máscara es un byte que se puede negar con los datos de dirección y paso antes de ser enviados por el puerto de control de pasos del driver de motores (Peters, 2015). 

$7 (Retardo de pasos, ms)

Siempre que los motores paso a paso completen un movimiento y se detengan, GRBL se encarga de deshabilitar los motores paso a paso predeterminadamente. El tiempo de bloqueo de los motores paso a paso es el espacio de tiempo que GRBL mantendrá bloqueados los motores antes de deshabilitarlos. 

Se puede establecer un valor de cero y desactivarlo o es posible que se necesite entre 25 a 50 milisegundos dependiendo del sistema. (El autor comenta que su máquina tiende a desviarse ligeramente si no tienen activada esta función.). También se puede poner este valor en 255 pero podría causar un sobrecalentamiento de los motores (Peters, 2015). 

$8 (Aceleración, mm/seg^2)

La aceleración en mm/segundo/segundo. No se necesita entender lo que esto significa, simplemente basta decir que un valor inferior proporciona una aceleración muy suave mientras avanza la ejecución del código-g y con un valor superior los movimientos son más ajustados y alcanzará velocidades mucho más rápidas (Peters, 2015).

$9 (Desviación de uniones, mm)

La desviación de uniones de curvas es utilizada por el gestor de aceleración para poder determinar la rapidez con que puede moverse por un camino. El cálculo matemático es un poco complicado, pero en general, si cambiamos por valores más altos se traducirá generalmente en movimientos más rápidos, que pueden llegar a ser bruscos (Peters, 2015). 

Los valores más bajos hacen que el gestor de aceleración sea más cuidadoso logrando un movimiento lento en las curvas. Es por esto que, si se llega a tener problemas al tomar las curvas con mucha velocidad, se puede disminuir este valor para solucionarlo (Peters, 2015). 
$10 (Arco, mm/segmento)

GRBL interpola círculos y arcos mediante la subdivisión de estos en líneas muy pequeñas. No hay necesidad de cambiar esto porque GRBL trabaja muy bien con su valor por defecto, tener una décima de milímetro es más que suficiente a menos que se trabaje en nanotecnología, pero si se encuentra problemas en el ruteo de los círculos se puede disminuir este valor (Peters, 2015).

$11 (Corrección de n-ésimo arco, int)

La siguiente es una opción avanzada que no se debe cambiar a menos que exista la necesidad. Para poder hacer arcos G02/03 en Grbl, Grbl calcula la ubicación del siguiente segmento de arco con una pequeña aproximación de ángulo (Peters, 2015).

$12 (Decimal n-ésimo, int)

Especifica cuantos decimales son tomados en cuenta por GRBL en la ejecución del código-g.

$13 (pulgadas reportadas, booleano)

GRBL v0.8 tiene una función que informa el posicionamiento en tiempo real proporcionando a los usuarios información sobre donde se encuentra la herramienta en ese momento. Por defecto está configurado con un valor de cero que significa mm, pero si se quiere trabajar en pulgadas se puede enviar un valor de 1 ($13=1) (Peters, 2015).

$14 (Inicio automático, booleano)

En un entorno más profesional, los operadores comienzan un trabajo cargando su código-g y luego pulsan el botón 'inicio del ciclo' (Cycle start) en la máquina. También se puede hacer esto automáticamente o simplemente ordenarlo desde el GUI GCODESENDER (Peters, 2015).

$15 (Habilitación de paso invertido, booleano)

En este paso es necesario saber si el controlador de motores necesita de un pulso alto o un bajo para activarse, por defecto se encuentra pulso bajo para habilitar. Si se requiere lo contrario, simplemente se invierte el pin de habilitación de motor escribiendo $15 = 1 (Peters, 2015). 


$16 (Límites de Fines de Carrera, booleano)

Los finales de carrera en la máquina son una medida de seguridad para ayudar a evitar que los ejes se muevan más allá de sus límites físicos pudiendo romper algún componente de la máquina. Simplemente se cablean algunos interruptores (mecánicos u ópticos) cerca del final de cada uno de los ejes, o donde se considere que podría haber problemas si el programa hace que la máquina se desplace demasiado hacia donde no debe (Peters, 2015).

Cuando el interruptor se active, el trabajo se detendrá inmediatamente y entra en el modo de alarma, lo que obliga al operario a revisar lo sucedido y reiniciar todo. Para utilizar los límites de final de carrera con GRBL, los pines designados para este trabajo en Arduino estarán declarados en alto con una resistencia de pull-up interna, por lo que solo hay que cablear un interruptor normalmente abierto y conectar un extremo al pin del Arduino y el otro extremo a tierra.

Para habilitar los finales de carrera se debe configurar en comando de la siguiente manera $16=1.Si se quiere limitar ambos lados del eje se puede usar dos finales de carrera simplemente conectándolos en paralelo.

$17 (Ciclo de Homing, booleano)

Para los que recién iniciamos en CNC, el ciclo Homing es utilizado para encontrar o localizar con precisión y exactitud la posición cero en una máquina al arrancar GRBL en cada sesión. Supongamos que estamos mecanizando algo, justo cuando estamos en medio trabajo, se va la luz; cuando volvamos a ejecutar GRBL este no va a tener ni idea de dónde está (Peters, 2015).

Nosotros tenemos la difícil tarea de averiguar dónde se encuentra; pero si tenemos Homing, siempre tendremos el punto de referencia localizado, lo único que debemos hacer es ejecutar el ciclo Homing y continuar con nuestro trabajo. Para configurar el ciclo Homing de GRBL, es necesario tener finales de carrera en posición fija donde no estorben el movimiento de los ejes, o si no el punto de referencia será erróneo (Peters, 2015).

$18 (Invertir dirección de Homing por máscara, int: binario)

GRBL asume que los finales de carrera trabajan como posición de Homing en la dirección positiva, primero mueve el eje z positivo, luego mueve los ejes x e y también en dirección positiva antes de localizar el cero de máquina, yendo y viniendo alrededor del final de carrera. Si la máquina tiene un final de carrera en la dirección negativa, la dirección Homing puede invertir el sentido de los ejes X Y y Z (Peters, 2015). 

$19 (Homing feed, mm/min)

El ciclo de Homing primero busca llegar a los finales de carrera a un seek rate alto (a una velocidad de desplazamiento alta) y después que los encuentra, se mueve a una velocidad de avance más lenta para poner a punto en la ubicación precisa el cero de la máquina. Homing feed significa que avance más lento. Ajústelo a cualquier valor de velocidad que proporcione una repetible y precisa localización del origen de la máquina (Peters, 2015).


1.3. [bookmark: _Toc436062991]                  Estructura y sistemas de control


En todas las máquinas CNC, se debe considerar dos parámetros fundamentales: la máquina y el tipo de control, según el material y maquinado que se desea obtener como producto final. 


1.3.1. [bookmark: _Toc436062992]             Sistemas de control


Los sistemas de control, se aplican esencialmente para las máquinas. Un sistema de control está definido como un conjunto de componentes que pueden regular su propia conducta o la de otro sistema con el fin de lograr un funcionamiento establecido, de modo que se reduzcan las probabilidades de fallos y se obtengan los resultados buscados (Leyva, 2009, pp. 11-15).   


1.3.1.1. [bookmark: _Toc436062993]             Lazo abierto 


El control de lazo abierto es aquel sistema en donde la señal de entrada se ejecuta directamente obteniendo un resultado fijo en la salida, la precisión de este resultado depende directamente de la calibración de nuestro sistema. Ante la presencia de perturbación, un sistema de lazo abierto tiende a dar resultados erróneos en su salida, motivo por el cual recibe el nombre de sistema no realimentado.

[bookmark: _Toc436144967]Figura 31-1. Sistema de control de lazo abierto.
Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


1.3.1.2. [bookmark: _Toc436062994]             Lazo cerrado 


A este sistema también se lo conoce como sistema retroalimentado, se lo conoce así porque cuyo control depende de la señal de salida, es decir se calcula un error que se corrige en el sistema de control, este error se lo obtiene de la diferencia entre la señal de entrada y señal de salida. Un sistema de control de lazo cerrado siempre implica el uso de una acción de control y realimentando el sistema para la reducción del error.  

[image: D:\Cristian\TESIS\retroalimentacion.png]
[bookmark: _Toc436144968]Figura 32-1. Sistema de control de lazo cerrado
Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


1.3.2. [bookmark: _Toc436062995]             Tipos de control según sus funciones 


Según las funciones que realizan las MHCNC, existen tres tipos de control que a continuación se nombran.

· Control punto a punto
· Control paraxial
· Control continuo


1.3.2.1. [bookmark: _Toc436062996]             Control punto a punto


En este tipo de control la máquina herramienta solo sigue los puntos establecidos por la programación. Es decir, que en este control se define los puntos a trabajar por la máquina herramienta, sin considerar la trayectoria a seguir para llegar a estos. 

Este tipo de control es el más simple o sencillo de todos los tipos de controles, por lo general se lo emplea en trabajos de taladro y soldadura por puntos, por lo cual es el más barato.

[image: D:\Cristian\TESIS\punto a punto.png]
[bookmark: _Toc436144969]		       	     Figura 33-1. Mecanizado punto a punto
                         Fuente: http://www.scribd.com/doc    


1.3.2.2. [bookmark: _Toc436062997]             Control paraxial


En este tipo de control se puede lograr una excelente precisión de la posición de la herramienta, la velocidad y la trayectoria en el mecanizado de una pieza, el recorrido lo realiza de forma controlada pero solo paralela u ortogonalmente a los ejes. Esto se da por la ausencia de la interpolación, es decir, solo puede mover y controlar un motor a la vez.

[image: D:\Cristian\TESIS\control paraxial.png]
[bookmark: _Toc436144970]		      	            Figura 34-1. Mecanizado paraxial.
                 Fuente: http://www.scribd.com/doc    


1.3.2.3. [bookmark: _Toc436062998]             Control continuo


Este tipo de control resulta mucho más preciso y conveniente que los controles anteriores porque tiene la capacidad de controlar varios ejes de forma simultánea, permitiendo que la herramienta pueda realizar cualquier recorrido en su área de trabajo, tanto líneas curvas como líneas rectas con cualquier tipo de inclinación. 

Esta capacidad de mover dos o más motores a la vez de forma simultánea y controlada, se llama interpolación. Este control es el más completo y por ende el más utilizado, aunque su precio sea muy elevado.
[image: D:\Cristian\TESIS\control continuo.png]
[bookmark: _Toc436144971]          			    Figura 35-1. Mecanizado continúo. 
     Fuente: http://www.scribd.com/doc    


1.3.2.4. [bookmark: _Toc436062999]             Interpolación lineal 


En la interpolación lineal como su nombre lo indica consiste en realizar un desplazamiento lineal, siguiendo una trayectoria rectilínea, esto se logra calculando el punto medio entre dos puntos de referencia. En su avance se van realizando correcciones de errores de desvió si existieren, en cualquiera de los ejes. Es decir, la fresa de la máquina se moverá en línea recta desde el principio al final del mecanizado, lo puede hacer en los tres ejes o solo en dos de ellos.

[image: D:\Cristian\TESIS\interpolacion lineal.png]
[bookmark: _Toc436144972]	          	     Figura 36-1. Interpolación lineal. 
       Fuente: https://sites.google.com/site/cncutn/fresadora/codigos-g


1.3.2.5. [bookmark: _Toc436063000]             Interpolación circular


Esta interpolación consiste en realizar movimientos circulares calculando puntos intermedios entre dos puntos inicial y final siguiendo una trayectoria de un arco circular. A medida que la fresa de la máquina avanza se corrigen errores de desvió en cualquiera de los ejes, que no tienen relación con el movimiento circular. 

[image: https://www.unirioja.es/servicios/sp/catalogo/online/fanuc/3_3.jpg]
[bookmark: _Toc436144973]		        	        Figura 37-1. Interpolación circular. 
           Fuente: https://www.unirioja.es/servicios/sp/catalogo


1.3.3. [bookmark: _Toc436063001]              Precisión, repetibilidad y resolución  


1.3.3.1. [bookmark: _Toc436063002]             Precisión 


“Cualidad que caracteriza la aptitud de un instrumento de medida para dar indicaciones próximas al valor verdadero de la magnitud medida, teniendo en cuenta tanto los errores sistemáticos como los errores aleatorios” (Ginjaume, 2005, pp. 265).
En la actualidad las máquinas herramientas, son capaces de lograr una precisión de maquinado de hasta 0.1mm.


1.3.3.2. [bookmark: _Toc436063003]             Repetibilidad 


Se considera como: “El grado de concordancia entre los resultados de mediciones de la misma magnitud, obtenidos con el mismo método, por el mismo operario, con los mismos instrumentos, en el mismo lugar y a intervalos de tiempo suficientemente cortos” (Ginjaume, 2005, pp. 265).

La repetibilidad de una máquina herramienta consiste en la comparación de cada pieza producida en la máquina herramienta para la obtención de la forma, tamaño y exactitud deseados. 

Es necesario establecer controles de mantenimiento preventivo para ayudar a mantener la repetibilidad en las máquinas herramientas y cuidar que la sujeción y colocación de la pieza sea lo más precisa posible.  


1.3.3.3. [bookmark: _Toc436063004]             Resolución 


La resolución se refiere “Al valor mínimo en que está dividida la escala o valor del último digito significativo que muestran los sistemas digitales” (Ginjaume, 2005, pp. 265).


1.3.4. [bookmark: _Toc436063005]             Programación CNC


[image: D:\Cristian\TESIS\proceso del cnc.png]
[bookmark: _Toc436144974]                       Figura 38-1. Flujo del procesamiento del CNC. 
                                Fuente: (Ing. Ricardo Jiménez, 2003)


1.3.4.1. [bookmark: _Toc436063006]             Programación de control numérico  


La programación que siempre se ha utilizado en la mayoría de las máquinas CNC se efectúa mediante un lenguaje de bajo nivel llamado G & M, este nombre lo recibe porque el programa está constituido por instrucciones Generales y Misceláneos.   

En este lenguaje de programación vectorial se describen acciones simples y entidades geométricas sencillas como líneas rectas y líneas curvas, conjuntamente con sus propiedades de maquinado como velocidad del husillo y avance de la fresa.

El código G se encarga de todas las funciones de movimientos como: movimientos rápidos, avances, avances radiales, pausas y ciclos de la máquina.     
Como ejemplo de código G se tiene la siguiente instrucción:

N26 G01 X10 Y5 F100

Traduciendo indica que en la instrucción numero 26 del programa, ejecute un corte con una velocidad de movimiento de 100mm/min en el eje X e Y con 10 y 5mm respectivamente.
Un programa es una sucesión de instrucciones en cadena enviadas por el computador a través de un cable serial o puerto paralelo a la máquina herramienta para el mecanizado de una pieza. A un programa se lo puede utilizar de dos maneras: manual y automático. 

Programación manual, el operador lo introduce de forma manual a la máquina en forma de códigos a través de un panel de control y de la computadora misma. Estos códigos pueden ser G, M, F, S y T.

· Códigos G: se encarga de la geometría de la trayectoria de la fresa. En la nomenclatura lleva la letra G seguida por una serie de números de 0 al 99.

· Códigos M: también conocidos como misceláneos realizan funciones como: controlar el flujo del programa, encendido de la máquina, calibrado de la máquina cuando se enciende, sentido de giro del mandril, reinicio o repetición de un bloque de instrucciones, control del rociador para el enfriamiento de la fresa y la pieza que se está maquinando, etc. Este código lleva la letra M seguida por una serie de números que van del 0 al 99.

· Código S: este comando sirve para: velocidad de giro del cabezal codificada, velocidad de giro del cabezal en RPM, velocidad de corte en m/minuto y parada del cabezal en grados. Para ejecutar este comando se escribe las revoluciones en números antepuesta de la letra S.

· Código F: este código sirve para la alimentación de cada uno de los ejes de la máquina controlando la velocidad de los mismos durante el mecanizado. En su estructura se escribe la letra F seguida del valor de mecanizado.   

· Código T: este código sirve para definir el número de herramientas de trabajo, permite seleccionar la fresa con la que se va a trabajar. Su estructura consiste en escribir la letra T seguida del número de la fresa.   

En las máquinas fresadoras CNC la programación es automática y la información digital es transmitida a través de un ordenador o PC. Este método es conocido como CAD/CAM, programación asistida por computador.




[bookmark: _Toc436145048]Tabla 4-1. Tabla de códigos “G” generales y “M” misceláneos para fresadoras CNC.
	Códigos G
	Códigos M

	Código
	Significado
	Código
	Significado

	G00
	Posicionamiento rápido (sin maquinar)
	M00
	Parada

	G01
	Interpolación  
	M01
	Parada opcional

	G02
	Interpolación circular (horaria)
	M02
	Reset del programa

	G03
	Interpolación circular (antihoraria)
	M03
	Hacer girar el husillo en sentido horaria

	G04
	Compás de espera
	M04
	Hacer girar el husillo en sentido antihorario

	G15
	Programación en coordenadas polares
	M05
	Frenar el husillo 

	G20
	Comienzo de uso de unidades imperiales (pulgadas)
	M06
	Cambiar de herramienta

	G21
	Comienzo de uso de unidades métricas
	M08
	Abrir el paso del refrigerante

	G28
	Volver al home de la máquina 
	M09
	Cerrar el paso de los refrigerantes

	G40
	Cancelar compensación de radio de curvatura de herramienta
	M10
	Abrir mordazas

	G41
	Compensación de radio de herramienta a la izquierda
	M11
	Cerrar mordazas

	G42
	Compensación de radio de herramienta a la derecha
	M13
	Hacer girar el husillo en sentido horario y abrir el paso de refrigerante

	G50
	Cambio de escala
	M14
	Hacer girar el husillo en sentido antihorario y abrir el paso de refrigerante

	G68
	Rotación de coordenadas
	M30
	Finalizar programa y poner el puntero de ejecución en su inicio

	G73
	Ciclos encajonados 
	M38
	Abrir la guarda

	G74
	Perforado con ciclo de giro antihorario para descargar virutas 
	M39
	Cerrar la guarda

	G76
	Alesado fino
	M62
	Activar salida auxiliar 1


	CONTINUACIÓN 

	G80
	Cancelar ciclo encajonado
	M67
	Esperar hasta que la entrada 2 este en ON

	G81
	Taladrado
	M71
	Activar el espejo en Y

	G82
	Taladrado con giro antihorario 
	M80
	Desactivar el espejo en X

	G83
	Taladrado profundo con ciclos de rotación para retiro de viruta
	M81
	Desactivar el espejo en Y

	G90
	Coordenadas absolutas
	M98
	Llamada de subprograma 

	G91
	Coordenadas relativas
	M99
	Retorno de subprograma

	G92
	Desplazamiento del área de trabajo

	G94
	Velocidad de corte expresada en avance por minuto

	G95
	Velocidad de corte expresada en avance por revolución 

	G98
	Retorno al nivel inicial 

	G99
	Retorno a nivel R

	G107
	Programación del 4to eje


Fuente: http://tecnoedu.com/Denford/GM.php 
Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015.


1.3.4.2. [bookmark: _Toc436063007]             Estructura de un programa CNC


Los programas en máquinas CNC están compuestos por una sucesión de bloques. Cada uno con una instrucción para el control. Los bloques pueden estar numerados o no, sino están numerados se van ejecutando en el orden que los va encontrando. La numeración de los bloques puede ser de uno en uno, de cinco en cinco o según el criterio del programador, continuado por los códigos sugeridos en la tabla4-1, no es necesario utilizar todos los ítems en una línea de instrucción. 

La numeración de los bloques debe ser siempre ascendente. Si hubiera un bloque con una numeración menor al anterior, el control detiene la ejecución de las instrucciones.


[image: D:\Cristian\TESIS\estructura de un programa en maquina CNC.png]
[bookmark: _Toc436144975]Figura 39-1. Estructura del bloque de programación CNC. 
Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


1.4. [bookmark: _Toc436063008]               Actuadores


Los actuadores son dispositivos eléctricos o mecánicos capaces de generar movimientos según las órdenes recibidas por la unidad de control. Cada sistema presenta características diferentes, por lo cual es necesario tenerlas en cuanta al momento de seleccionar el tipo de actuador más conveniente. 

A continuación, se presenta algunas características a considerar:

· Potencia
· Controlabilidad
· Peso y volumen
· Precisión
· Velocidad
· Mantenimiento 
· Coste




1.4.1. [bookmark: _Toc436063009]             Motores eléctricos 


Son dispositivos que constan de dos partes: estator y rotor, pueden transformar la energía eléctrica en energía mecánica, motivo por el cual se los utiliza para proporcionar potencia en varias aplicaciones como, por ejemplo: domesticas, comerciales e industriales. Por ser versátil y tener una operación altamente económica no se utiliza otras fuentes de potencia para movimiento.

Los motores más utilizados para máquinas CNC dentro del campo industrial de manufactura PCB son los motores paso a paso.  


1.4.1.1. [bookmark: _Toc436063010]             Motor paso a paso  


Es un dispositivo electromecánico, cuya función es la trasformación de impulsos eléctricos provenientes de controladores en desplazamientos mecánicos, se mueve un paso por cada pulso, por lo cual son muy utilizados en sistemas de control digital.

[image: MOTOR PASO A PASO UNIPOOLAR 2 FASES TIPO 1. Clic para ampliar]
[bookmark: _Toc436144976]		                          Figura 40-1. Motor paso a paso.   
                  Fuente: http://www.superrobotica.com/

Los pasos de este tipo de motores pueden variar desde 90° hasta pequeños movimientos de 1.8°, es decir, que para los 90° se necesitarán cuatro pasos para completar una vuelta (360°) y para los 1.8° serán necesarios 200 pasos para completar una vuelta (360°).

Partes de los motores paso a paso

Los motores paso a paso están formados por un rotor, que a su vez está constituida por imanes y un rotor que consta de bobinas excitadoras. Toda la excitación de las bobinas debe ser manejada por un controlador. 
[image: http://todorobot.com.ar/wp-content/uploads/2014/09/shaft.jpg]
[bookmark: _Toc436144977]		     	      Figura 41-1. Rotor del motor paso a paso.   
        Fuente: http://www.todorobot.com.ar

[image: http://todorobot.com.ar/wp-content/uploads/2014/09/stator.jpg]
[bookmark: _Toc436144978]			      	     Figura 42-1. Estator del 
                                                                     motor paso a paso.   
        Fuente: http://www.todorobot.com.ar

Los motores paso a paso con imán permanente se dividen en dos tipos: unipolares y bipolares

Unipolares, por lo general estos motores tienen 4, 5,6 u 8 cables de salida, dependiendo de cómo se haya conectado internamente, también son más simples de controlar porque la corriente circula lo realiza en el mismo sentido. 

[image: http://server-die.alc.upv.es/asignaturas/lsed/2002-03/MotoresPasoaPaso/imagenes/tip1.gif]
[bookmark: _Toc436144979]	                  Figura 43-1. Motor paso a paso unipolar.
       Fuente: http://server-die.alc.upv.es/asignaturas

Bipolares, estos motores por lo general tienen cuatro cables de salida y en su funcionamiento necesitan ciertas configuraciones para ser controlados, debido a los cambios que presenta en la dirección del flujo de la corriente a través de las bobinas en las secuencias apropiadas para realizar los movimientos del motor.

[image: http://server-die.alc.upv.es/asignaturas/lsed/2002-03/MotoresPasoaPaso/imagenes/tip3.gif]
[bookmark: _Toc436144980]	         	               Figura 44-1. Motor paso a paso bipolar.
                     Fuente: http://server-die.alc.upv.es/asignaturas

Parámetros de los motores paso a paso  

· Par dinámico de trabajo. - Es el momento máximo que el motor es capaz de desarrollar sin perder pasos (Ramos, 2003). 
· Par de mantenimiento: Es el par mayor que el par dinámico y funciona como freno para conservar el rotor en una posición estable (Ramos, 2003). 
· Par de detención: También conocido como torque de detención, son los encargados de mantener firmemente a un motor paso a paso en su posición cuando no está girando. (Ramos, 2003) 
· Ángulo de paso: Se define como el avance angular que se produce en el motor por cada impulso de excitación. Se mide en grados, siendo los pasos estándares más importantes los que se muestran en la tabla5-1 (Ramos, 2003). 

· Nº de pasos por vuelta: Cantidad de pasos que necesita el rotor para realizar una revolución;  (Ramos, 2003).
· Frecuencia de paso máximo: Número de pasos por segundo que es capaz de recibir el motor en buen funcionamiento (Ramos, 2003). 
· Momento de inercia del rotor: Es su momento de inercia asociado que se expresa en gramos por centímetro cuadrado (Ramos, 2003).

                                  









[bookmark: _Toc436145049]                                  Tabla 5-1. Pasos estándares.
[image: D:\Cristian\TESIS\tabla de gradoas de giro de un motor paso a paso.png]
                                               Realizado por: (Ramos, 2003)
                                               Fuente: (Andrea Llerena, 2014)  	


1.5. [bookmark: _Toc436063011]               Controlador de motor paso a paso 


Son dispositivos electrónicos conocidos como drivers, su circuitería está formada por transistores bipolares, Mosfet, y elementos adicionales. Para su funcionamiento, recibe pulsos de corriente de control desde un computador y proporciona potencia en la salida con niveles de corriente necesarios para accionar los motores.

Existen una variedad de drivers para motores paso a paso y su selección depende directamente del tipo de motor paso a paso que se vaya a utilizar. Uno de los criterios es la corriente máxima que pueden entregar, normalmente se debe escoger los de mayor corriente que este en un rango de 1,7-1,8A.

A continuación, se mencionará los controladores de mayor relevancia para una máquina CNC:


1.5.1. [bookmark: _Toc436063012]             Controlador JP-382A


Este controlador recibe una serie de instrucciones del Arduino UNO, y este a su vez las recibe de un computador u ordenador a través del cable puerto USB, estas instrucciones son convertidas en pulsos eléctricos, para luego accionar los motores de cada uno de los ejes de la máquina. Este controlador está fabricado a base a base de los TB6560AHQ de Toshiba. 

[image: https://fbcdn-sphotos-f-a.akamaihd.net/hphotos-ak-xfp1/v/t34.0-12/12166401_896806540368811_783912735_n.jpg?oh=db6b139d93deff07171deed69f1581ce&oe=56294D81&__gda__=1445483563_274c3216821bcf137d9c1e192aaafd0e]
[bookmark: _Toc436144981]                                    Figura 45-1. Controlador JP-382A
                                                  Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


1.5.2. [bookmark: _Toc436063013]             Controlador A4988


Este controlador para motores paso a paso bipolar cuenta con un ajuste de limitación de corriente, sobre corriente y de la sobre temperatura de protección y cinco resoluciones diferentes de microstep (hasta 1/16 pasos). Opera desde 8-35V y puede entregar aproximadamente 1A por fase sin un disipador de calor o flujo de aire, también está equipado para entregar 2A por fase con suficiente refrigeración adicional. 

[image: https://a.pololu-files.com/picture/0J4578.200.jpg?c171a8f68733c1b8c094925e676964d5]
[bookmark: _Toc436144982]			                  Figura 46-1. Controlador para 
                                                                         motores PAP A4988
                                                                              Fuente: https://www.pololu.com/product/





1.6. [bookmark: _Toc436063014]               Interface de comunicación  


1.6.1. [bookmark: _Toc436063015]             Puerto paralelo   


Es una interfaz que posibilita el intercambio de información digital. Dichos puertos pueden ser físicos o virtuales. Este tipo de conexión permite la circulación de información a la máquina CNC a través de paquetes de datos que circulan simultáneamente mediante un cable. 

En el ordenador, el puerto paralelo se halla integrado a la placa madre y en la máquina fresadora CNC se haya integrada en el controlador de motores. Permitiendo una comunicación bidireccionalmente mediante diferentes hilos que integran este tipo de puertos.

[image: http://www2.configurarequipos.com/imgdocumentos/jPANELTPC/conector_paralelo.jpg]
[bookmark: _Toc436144983]				Figura 47-1. Puerto paralelo.
				Fuente: http://www.configurarequipos.com

[bookmark: _Toc436145050]Tabla 6-1. Configuración del puerto paralelo.
[image: D:\Cristian\TESIS\pines del puerto paraleo.png] 
Fuente: http://www.mileti.com.ar/apuntes/puerto_paralelo_01.pdf
Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015.
1.6.1.1. [bookmark: _Toc436063016]             Registros   


[image: D:\Cristian\TESIS\registros puerto paralelo.png]
[bookmark: _Toc436144984]	  	Figura 48-1. Registros del puerto paralelo.
	   Fuente: http://www.etitudela.com/fpm/comind/downloads/elpuertoparalelo.pdf

Registro de datos, el registro de estado se halla en LPT_BASE. Estos registros pueden ser leídos y escritos desde el procesador, al escribir dichos datos causan que aparezcan en los pines 2 a 9 del conector del puerto. La forma de leer los registros va desde el último dato escrito, es decir, no toma lecturas de los estados de los pines; para lograr dicha lectura es recomendable usar un puerto paralelo bidireccional.

Registro de estado, este registro es de solo lectura y está en la LPT_BASE+1. En este registro se ignoran las escrituras, ya tiene como función proporcionar información acerca del estado de los 5 pines de entrada durante la lectura.

Registro de control, es de lectura/escritura y se encuentra en la LPT_BASE+2, también controla la transferencia de información.      


1.7. [bookmark: _Toc436063017]               Sensores de contacto  


También conocidos como interruptores, están constituidos por una parte móvil y una fija, normalmente son contactos que según la operación que realicen pueden tomar los siguientes estados: normalmente abierto (NA) o normalmente cerrado (NC). Son utilizados para la detección de la posición límite de componentes mecánicos o final de un recorrido. Como por ejemplo el abre y cierra automático de una ventana o puerta. 
Los sensores principales son los llamados fines de carrera o finales de carrera, los mismos que constan de una pieza NA separada de la móvil y solo conduce corriente cuando la parte móvil es accionada y una pieza NC que está unida a la móvil permitiendo el paso directo de la corriente, la misma que si se llegase a separar impide el flujo de corriente.

[image: http://recursostic.educacion.es/secundaria/edad/4esotecnologia/quincena11/imagenes_11/final_de_carrera.jpg][image: final carrera]
[bookmark: _Toc436144985]			Figura 49-1. Final de carrera y su simbología.
			Fuente: http://ww.superrobotica.com


1.8. [bookmark: _Toc436063018]               Arduino UNO 


Arduino es una plataforma de hardware y software libre, constituido por una placa en la que se encuentra un microprocesador Atmega 8, posee entradas y salidas analógicas/digitales y un entorno de desarrollo, la misma que facilita la realización de múltiples proyectos electrónicos. Su característica es que tiene integrado un puerto USB, por el cual se puede cargar instrucciones de programación desde cualquier computador.

Al ser una plataforma libre, tanto su diseño como su distribución, puede usarse libremente para cualquier tipo de proyecto sin necesidad de licencia.

[image: arduino01]
[bookmark: _Toc436144986]                                           Figura 50-1. Arduino UNO.
	                           Fuente: http://platea.pntic.mec.es/~mhidalgo/edubasica/01arduino
1.9. [bookmark: _Toc436063019]               PWM (modulación por ancho de pulso) 


La función PWM conocidas sus siglas por modulación de nacho de pulsos, el mismo que es muy utilizado en circuitería actual de potencia, verificando la energía de inercia. Es decir considera los distintos cambios en el proceso de operación de cierta señal periódica. Podemos obtener diversos objetivos, como por ejemplo el controlar la energía de determinada carga o realizar una transmisión de datos.

PWM exige un circuito donde sus partes son totalmente diferenciables entre ellas. Su comparador interno es el cual se cambia en el nexo, teniendo una salida y dos entradas diferentes. Cuando este vaya a ser programado se considera que una entrada proporciona una zona a la señal moduladora.

En la otra entrada se conecta un oscilador de dientes de sierra para un desempeño óptimo y eficaz de la operación. La señal que obtenemos de dicho oscilador establece la frecuencia de salida. Sin duda es uno de los elementos más utilizado y eficaz, de acuerdo con lo que se tiene disponible en el mercado electrónico.

El PWM por lo general se aplica a circuitos para la regulación de velocidad de giro de un motor eléctrico de inducción o asíncronos, ya que mantienen el par de motor constante y no suponen un desaprovechamiento de la energía eléctrica. También se utiliza para enviar información de manera analógica, ya que son útiles para comunicarse de forma analógica con sistemas digitales (Amaia Azpitarte, 2013). 

[image: http://1.bp.blogspot.com/-3WkUmAgin54/TszK9-0BoII/AAAAAAAAAnM/IYIf_fC5L1M/s640/pwm2.jpg]
[bookmark: _Toc436144987]              Figura 51-1. Graficas del PWM.
                                     Fuente: http://mimaquetaz.blogspot.com/2011/11/pwm-i.html



[bookmark: _Toc434485420][bookmark: _Toc436063020][bookmark: _Toc434485421]CAPÍTULO II



2. [bookmark: _Toc436063021]               DISEÑO E IMPLEMENTACIÓN


2.1. [bookmark: _Toc434485422][bookmark: _Toc436063022]               Esquema de control 


El sistema de control consta principalmente de tres partes: el ordenador, la unidad de control, y la máquina herramienta.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\esquema de control.png]
[bookmark: _Toc434503777][bookmark: _Toc436144988]       Figura 1-2. Esquema de control de máquina CNC.
          Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

En base a este esquema se empezó primero por explicar la parte del software, después la unidad de control o gabinete de control, para finalizar con la mecánica de la máquina.


2.2. [bookmark: _Toc434485423][bookmark: _Toc436063023]               Software


2.2.1. [bookmark: _Toc434485424][bookmark: _Toc436063024]             Uso del software CAD (diseño asistido por computadora)

Para el diseño de las placas de circuito impreso hemos utilizado dos software: Proteus 8 Profesional y Eagle 7.1.0 Profesional. Los dos tienen plataformas muy intuitivas y fáciles de entender.


2.2.1.1. [bookmark: _Toc436063025]             Generación de archivos gerber


Se tomó como ejemplo la generación de archivos gerber en ARES PROTEUS, antes de realizar este procedimiento se debe tener terminado por completo el diseño de la PCB y proceder con los siguientes pasos.

Acceda al menú “Output - Generate Gerber/Excellon Files“.  

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\captura1.png]
[bookmark: _Toc434503778][bookmark: _Toc436144989]        Figura 2-2. Menú generar archivos gerber.
           Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

En este paso se encuentra la configuración de los parámetros para la generación del archivo gerber, entre los cuales están: 

· El nombre de los archivos gerber.
· La ruta donde se guardarán en nuestra PC. 
· El tipo de archivo en el que se exportarán. 
· Las capas de la PCB a generar. 
· El formato gerber. 
· Las unidades. 
· La resolución, etc.

En la siguiente ilustración se muestra la configuración básica de una PCB de doble capa.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\captura2.png]
[bookmark: _Toc434503779][bookmark: _Toc436144990]                       Figura 3-2. Configuración para archivo gerber.
                                Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Después de configurar todos los parámetros en la ventana anterior, seguimos con un clic en el botón OK. En la ruta especificada en la ventana anterior, se guarda un archivo en formato RAR, que después de descomprimirlo obtendremos una carpeta con los archivos gerber de nuestro diseño.

[image: ]
[bookmark: _Toc434503780][bookmark: _Toc436144991]       Figura 4-2. Archivos gerber generados.
          Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


2.2.1.2. [bookmark: _Toc436063026]             Problema de los archivos gerber generados por Proteus.


En el desarrollo de la investigación, al momento de abrir los archivos gerber en el software FLATCAM se encontró un problema; el cual no permitía abrir ningún archivo gerber generado por Proteus, pero los archivos que se generaban en Eagle y Multisim no presentaban esta falla.

No se podía dejar pasar este error porque existen muchas personas que prefieren a Proteus como software de diseño de PCB´s. Después de una larga investigación y de una comparación entre los archivos gerber generados por Proteus con los de Eagle, resultó que en los archivos de Eagle no existían signos “+” como en los de Proteus, tal como se muestra en la siguiente imagen.

[image: ]
[bookmark: _Toc434503781][bookmark: _Toc436144992]                                Figura 5-2. Archivo gerber con signos “+”.
                                            Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Revisando el formato RS274X, para saber si era una falla de Proteus, se obtuvo que este formato dejaba a libre decisión el uso de los signos “+”. FLATCAM no acepta archivos gerber que contengan estos signos hasta la versión 8.3. 

Decidimos eliminar los signos “+” utilizando el menú de edición del editor de texto Bloc de Notas, luego de esto intentamos nuevamente cargar el archivo en FLATCAM y obtuvimos los resultados esperados. 


2.2.2. [bookmark: _Toc434485425][bookmark: _Toc436063027]             Uso de software CAM (manufactura asistida por computadora).


El software elegido tanto por su gran capacidad como por su interfaz amigable con el usuario es FLATCAM, donde se configura principalmente la velocidad de fabricación de las PCB, dimensiones de herramienta, calibración de la máquina, entre otras. 


2.2.2.1. [bookmark: _Toc436063028]             Generación de código-G:


Para la generación de código-g en FLATCAM se necesitan los archivos gerber que obtenidos en el apartado anterior. A continuación, se explicará el proceso que se debe seguir en FLATCAM con un ejemplo sencillo. Hay que tomar en cuenta que este software es muy potente, si se requiere más información refiérase a la información en el manual del ANEXO 1.

Una vez abierto el programa, damos clic en File y luego en Open Gerber.

[image: ]
[bookmark: _Toc434503782][bookmark: _Toc436144993]  Figura 6-2. FLATCAM abrir archivo gerber.
   Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
Después de esto se abrirá el explorador de archivos para buscar el gerber que se convertirá en código-g. Una vez que el archivo este abierto aparecerá en la pantalla el diseño de la PCB en un color verde.

[image: ]
[bookmark: _Toc434503783][bookmark: _Toc436144994]                             Figura 7-2. FLATCAM Archivo gerber abierto.
                                        Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

El siguiente paso, es dar clic en el menú SELECTED y modificar según nuestras necesidades los recuadros: 

· Tool dia: Diámetro de la herramienta de fresado.
· Width (#pases): Es el número de veces que pasará la herramienta por el camino a seguir.
· Pass overlap: Es la distancia entre la línea de la PCB y la línea que seguirá la herramienta.

Luego de esto damos clic en Generate Geometry. El resultado que se obtiene es el mostrado en la imagen de abajo.

[image: ]
[bookmark: _Toc434503784][bookmark: _Toc436144995]Figura 8-2. FLATCAM Geometría generada.
Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Queda por configurar:

· Cut Z: Es la profundidad de fresado, se mide en mm.
· Travel Z: Este valor se debe declarar en 1.
· Feed Rate: Es la velocidad que los ejes tomaran en el momento del fresado.
· Tool dia: Diámetro de la herramienta de fresado.

Después de configurar estos parámetros damos clic en Generate y obtendremos el siguiente resultado. Donde se dibujará el camino por donde la máquina CNC recorrerá en varios ciclos señalados por números.

[image: ]
[bookmark: _Toc434503785][bookmark: _Toc436144996]                 Figura 9-2. FLATCAM ciclos de recorrido máquina CNC.
                       Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

El último paso es exportar el código-g seleccionando el archivo iso_cnc y dando clic en Export G-Code.


2.2.3. [bookmark: _Toc434485426][bookmark: _Toc436063029]             GRBL, software para controlar máquina CNC con Arduino.


Hay muchos softwares para controlar máquinas CNC, pero la mayoría se basa en GRBL que es el más completo y el indicado para nuestro proyecto. En el capítulo anterior se muestran las características de esta potente herramienta de código libre.


2.2.3.1. [bookmark: _Toc436063030]             Cargar firmware de GRBL en Arduino:


El firmware de GRBL es multiplataforma por lo que funciona en Linux, Mac y Windows en este apartado se explicará la instalación en Windows.

Para cargar el firmware de GRBL en una placa Arduino debemos seguir las siguientes instrucciones:

· Primero, conectar la placa Arduino UNO a cualquier puerto USB del ordenador y determinar el puerto que se le asignó en el administrador de dispositivos.

· Descargar el firmware. hex de GRBL (se ha utilizado la versión v0.8).
(https://www.dropbox.com/s/tx53kgskn62q6lg/grbl_v0_8c_atmega328p_16mhz_9600.hex?dl=0).

· Descargar el archivo XLoader y luego descomprimirlo.
(https://www.dropbox.com/s/kitwbfy8w0hvrnk/XLoader.zip?dl=0).

· Abrir XLoader y seleccionar el puerto COM asignado para la placa Arduino en la parte inferior izquierda del menú.

[image: ]
[bookmark: _Toc434503786][bookmark: _Toc436144997]                                                     Figura 10-2. Xloader 
                                                                           Configuración.
                                                	                   Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

· Seleccione el dispositivo apropiado en la lista despegable llamada “Device (Dispositivo)”, en este caso Uno (Aatmega328).

· Comprobar la velocidad de transmisión correcta del dispositivo (Arduino UNO atmega328/ 115200 Baudios, Arduino Duemilanove y Arduino Nano atmega328/ 57600 Baudios).

· Hacer clic en el botón examinar para buscar la dirección del archivo GRBL v 0.8.

· Una vez encontrado el archivo anterior, utilizar el botón Upload para subir el código a la placa Arduino UNO.

Después de hacer clic en cargar código se verá en la placa Arduino parpadear intensamente los leds TX/RX y finalmente se mostrará la cantidad de bytes subidos en la parte inferior de Xloader. 


2.2.4. [bookmark: _Toc434485427][bookmark: _Toc436063031]               Interfaz gráfica de GRBL.


En la actualidad existen muchos GUI desarrollados de código abierto de los cuales se decidió usar el “Universal GcodeSender” en su versión 1.0.8 para Windows. Se intentó con otros GUI pero no se tuvo buenos resultados, presentándose principalmente problemas de comunicación con la placa Arduino, arrojando un error inexplicable en la ejecución del trabajo.

Los GUI que dieron problemas fueron GRBL Controller en las versiones 3.6.1 y 3.6.2, estos son modificaciones hechas por desarrolladores de software que se basan en Universal GcodeSender, esta interfaz gráfica es incluso recomendada por el creador de GRBL.

[image: ]
[bookmark: _Toc434503787][bookmark: _Toc436144998]                                    Figura 11-2. Ventana de inicio de Gcode Sender.
                                                  Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Gcode Sender ayuda a configurar a través de comandos “$$” los parámetros de GRBL. Además, que cuenta con un control de los movimientos de la máquina con el teclado de la computadora, así como también un visualizador en tiempo real de la posición de la herramienta. 

Primero se debe conectar la placa Arduino a un puerto USB libre y abrir Gcode Sender, luego seleccionar el puerto que ha sido asignado para Arduino y finalmente hacer clic en Open. Una vez realizado el proceso anterior, Gcode Sender se conectará con GRBL y emitirá un mensaje de confirmación como el que aparece en la consola de la parte inferior de la imagen anterior. 
 

2.2.5. [bookmark: _Toc434485428][bookmark: _Toc436063032]               Configuración de GRBL para la máquina CNC.


Con el GRBL conectado a Gcode Sender, en el recuadro de comandos digitamos “$$” y presionamos la tecla ENTER; GRBL nos responderá con la configuración actual. A continuación, se explicará paso a paso la configuración necesaria para que nuestro proyecto funcione bien.

[image: ]
[bookmark: _Toc434503788][bookmark: _Toc436144999]                    Figura 12-2. Configuración actual de GRBL.
                            Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


2.2.5.1. [bookmark: _Toc436063033]             Pasos por milímetro de los ejes x, y, z:


La transmisión de movimiento de los 3 ejes de la máquina CNC se realiza a base de varillas roscadas. Para calcular los pasos por milímetro hay que conocer:

· Pasos por revolución:

Los motores paso a paso utilizados para los tres ejes son de 1.8° es decir, de 200 pasos por revolución.
[image: C:\Users\JoseEnrique\Downloads\12171386_896773000372165_1450093052_o.jpg]
[bookmark: _Toc434503789][bookmark: _Toc436145000]                		       Figura 13-2. Motor Paso a Paso.
                                                               Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

· Micro pasos: 

Los micro pasos que envía el controlador de los motores JP-382A son 8.

· Milímetros por revolución:

Para el cálculo de este elemento hay que usar la siguiente fórmula:


Dónde: 

p: Es el paso de la rosca de la varilla de tornillo, el cual es de 2mm; Hay que recordar que el paso de la rosca es la distancia entre dos filetes juntos de una misma hélice que medimos en mm.

N: Es el número de vueltas que da el husillo o varilla.
                                                     


Con todos los elementos ya conocidos se aplica la fórmula para saber qué valor debemos ubicar en el ítem 0, 1 y 2.






Para comprobar este valor se le hizo fresar a la máquina una línea de 2cm, luego se hizo una medición con un calibrador y efectivamente fueron 2cm los fresados por la máquina en la realidad. En la configuración de GRBL por medio de GCODESENDER escribimos las siguientes líneas de comando seguidas cada una de la tecla ENTER.

$0=400.0000 (x, step/mm)
$1=400.0000 (y, step/mm)
$2=400.0000 (z, step/mm)


2.2.5.2. [bookmark: _Toc436063034]             Step pulse (useg):


No fue necesario modificar el step pulse, probamos a 10 microsegundos que ya estaban establecidos por defecto y no nos dio problema alguno.

$3=10 (step pulse, usec)


2.2.5.3. [bookmark: _Toc436063035]             Feed rate y seek rate:


Estos parámetros de velocidad en movimientos rápidos dentro del área de trabajo se configuraron por observación; es decir probando con un valor bajo y luego subiéndolo hasta determinar el valor adecuado para el movimiento de la máquina. Principalmente este valor depende de la estructura de la máquina, algunas máquinas funcionan con 250 a 500, nuestra máquina funcionó muy bien a 1000. 

Para que se entienda bien, esta velocidad es para los movimientos de los ejes en el momento que ha terminado un ciclo de fresado y continua en otro punto. 

$4=1000.0000 (default feed, mm/min)
$5=1000.0000 (default seek, mm/min)


2.2.5.4. [bookmark: _Toc436063036]             Step port invert mask: 


Este parámetro tuvo que cambiarse porque los ejes se movían en sentido contrario de lo indicado por medio del software. El valor por defecto era 28 ($6=28), luego de analizar detenidamente la documentación de GRBL encontramos que si se cambiaba el valor de 28 por 96 la máscara de bits tomaba otro valor que hacía que las direcciones de movimientos de los motores cambien y se ajuste a las necesidades requeridas.

$6=96 (step port invert mask, int: 01100000)


2.2.5.5. [bookmark: _Toc436063037]             Acceleration (aceleración):


La aceleración es mejor dejarla en 100 porque es un valor bajo comparado con la velocidad máxima (default feed) anteriormente declarada en 1000. Si se quiere deshabilitar la aceleración se debe poner un valor por encima del valor de default feed. La aceleración se utiliza para que poco a poco vaya tomando un más de velocidad mientras realiza un fresado, pero este valor se debe manejar con precaución ya que puede causar una velocidad excesiva que ocasione fallas en el fresado.

$8=100.0000 (acceleration, mm/sec^2)



2.2.5.6. [bookmark: _Toc436063038]             Tolerancia de arco: 


No se modificó la tolerancia de arco, porque el valor que viene por defecto es suficiente para trabajar haciendo circunferencias y arcos, se trata de una décima de milímetro que no se debe cambiar a menos que se trabaje en piezas de nanotecnología.

$10=0.1000 (arc, mm/segment)


2.2.5.7. [bookmark: _Toc436063039]             Número de decimales:


Solo se tiene que especificar el número de decimales que GRBL tiene que tomar en cuenta al momento de enviar el código-g; para nuestro caso 3 decimales son más que suficientes ya que nuestra precisión requerida es de 0.2mm.

$12=3 (n-decimals, int)


2.2.5.8. [bookmark: _Toc436063040]            Cambiar pulgadas o milímetros:


Como las varillas roscadas son milimétricas, esto significa que, para no tener ningún problema en las dimensiones del fresado de Placas de Circuito Impreso, el sistema de unidades estará declarado en milímetros. Si se cambia el valor de 0 por 1 el sistema trabajará con pulgadas.

$13=0 (report inches, bool)


2.2.5.9. [bookmark: _Toc436063041]           Invert step enable (habilitar el controlador):


No fue necesario modificar este parámetro porque cualquiera que sea el valor 0 o 1 no influye en nada porque los pines de ENABLE de los TB6560AHQ están conectados directamente a Vcc en el controlador de motores.
$15=0 o 1 (invert step enable, bool)


2.2.5.10. [bookmark: _Toc436063042]límites críticos o hard limits:


Para habilitar los límites de la máquina es necesario cambiar el valor por defecto que es 0, por 1 en el ítem 16. Se consideró muy importantes los finales de carrera (interruptores) en la estructura mecánica de la máquina porque ayudan a que los motores no quieran seguir girando cuando un eje determinado haya llegado a su fin de carrera, esto puede ocasionar que las juntas del motor con la varilla roscada se rompan o peor aún quemar los motores paso a paso. 
 
$16=1 (hard limits, bool)

Todos los demás parámetros no fueron configurados porque no intervienen en nuestro proyecto, pero en el capítulo anterior se detalla cada uno de estos, como conocimientos complementarios.


2.3. [bookmark: _Toc434485429][bookmark: _Toc436063043]                 Hardware:


2.3.1. [bookmark: _Toc434485430][bookmark: _Toc436063044]              Montaje del gabinete de control:


2.3.1.1. [bookmark: _Toc436063045]             Montaje eléctrico: 


Para esta etapa utilizamos la fuente de voltaje que viene incorporada en la máquina CNC, esta tiene una etapa de transformación de 110V a 24V AC. También una etapa de rectificación de AC a DC con sus respectivos reguladores de voltaje para los diferentes componentes del sistema.

[image: ]
[bookmark: _Toc434503790][bookmark: _Toc436145001]                		      Figura 14-2. Etapa Eléctrica (transformador y JP-1482).                         
                                                              Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


2.3.1.2. [bookmark: _Toc436063046]             JP-1482 control spindle motor (husillo).


Esta tarjeta que controla el motor spindle recibe alimentación del secundario del transformador de 24 y 48V; los 24V son rectificados y regulados a 5V para alimentar el sistema eléctrico del procesador y el otro voltaje es igualmente rectificado y regulado para el spindle motor (husillo o taladro). También cuenta con un integrado STC15W408AS que con un adaptador de USB a UART, compilador Keil C51, uVision4, y una aplicación de ISP STC se puede programar.

Este controlador a más de tener etapa de rectificación y regulación, tiene una salida de PWM que está gobernada por el integrado STC15W408AS mencionado anteriormente. El esquemático de esta tarjeta se puede observar en la siguiente imagen.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\JP1482 ESQUEMATICO.png]
[bookmark: _Toc434503791][bookmark: _Toc436145002]Figura 15-2. Diagrama esquemático del JP-1482.
Fuente: https://cdn.hackaday.io/images/2208021438080424628.png

El diagrama esquemático anterior se puede seccionar en varias etapas para su mejor compresión, Las siguientes imágenes muestran las diferentes etapas como: conexiones de microcontrolador, control de señales, detección de sobre corriente y salida para el motor spindle.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\esquema3.png]
[bookmark: _Toc434503792][bookmark: _Toc436145003]                       Figura 16-2. Salida del motor spindle y detección de sobre corriente.
                                Fuente: https://cdn.hackaday.io/images/5011051438080382225.png

La etapa de control de PWM se realiza con el circuito STC15W408AS, que es un microcontrolador especial programable, este viene incorporado en la tarjeta de control JP-1482. En la siguiente imagen se muestra los principales pines de conexión y alimentación, así como la salida de PWM.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\esquema1.jpg]
[bookmark: _Toc434503793][bookmark: _Toc436145004]         Figura 17-2. Conexión micro controlador STC15W408AS.
             Fuente: https://cdn.hackaday.io/images/3484861438004217554.jpg 

La etapa de alimentación y rectificación del JP-1482 consta de entrada de voltaje AC 40V y de 20V, la primera para la regulación de 5V para el microcontrolador y la alimentación de los motores. La segunda parte para la alimentación del ventilador disipador.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\esquema4.jpg]
[bookmark: _Toc434503794][bookmark: _Toc436145005]    Figura 18-2. Fuentes de alimentación y salida del ventilador.
      Fuente: https://cdn.hackaday.io/images/7811151438004556011.jpg

El siguiente diagrama muestra la conexión del potenciómetro que regula el ciclo de PWM, también la adecuación de la señal para el encendido del motor spindel, esta se hace a través de opto acopladores para su mejor rendimiento.
[bookmark: _Toc434503795][bookmark: _Toc436145006][image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\esquema2.jpg]Figura 19-2. Control de señales.
Fuente: https://cdn.hackaday.io/images/473591438004431636.jpg


2.3.1.3. [bookmark: _Toc436063047]             Montaje de control


En esta parte del gabinete, los componentes son: el controlador de motores, la placa Arduino UNO, interruptores finales de carrera, PWM Husillo, etc. 

Características de la salida PWM de JP-1482.

Lo primero que hay que notar es el funcionamiento del PWM con respecto al potenciómetro que está ubicado en el gabinete de control de la máquina. El PWM de la salida de micro STC15W408AS es invertido y después de pasar a través de un opto acoplador y un transistor NPN se invierte para que el motor funcione. El diagrama esquemático se muestra en la siguiente imagen.
[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\diagramapwm.jpg]
[bookmark: _Toc434503796][bookmark: _Toc436145007]Figura 20-2. Diagrama esquemático del control de PWM.
Fuente: https://cdn.hackaday.io/images/1088751438154281928.jpg

La resistencia máxima del potenciómetro es 3.312KOhm, el PWM no empezó hasta que la resistencia cayó a un valor de 3.125KOhm, que según los cálculos en el divisor de voltaje equivale a 1.7V. El PWM inició aproximadamente en 20% y aumentó linealmente a 100% mientras la resistencia se redujo a un valor de 0. 

Un análisis más detenido hizo notar que el movimiento en el potenciómetro no produce cambios inmediatos en el PWM, tarda alrededor de 4 segundos, esto significa que el 80% utilizable del PWM se reparte en 4 segundos; haciendo una división simple se puede estimar que el PWM aumenta un 1% cada 50 milisegundos. También se notó que la frecuencia del PWM es de 1.28KHz aproximadamente. Todos estos datos se pueden notar en las imágenes posteriores.
 
[bookmark: _Toc436145051]                            Tabla 1-2. Tabla de datos para gráfica de PWM.
	Resistencia (Ohm)
	Voltaje 
	Tiempo (us)
	Porcentaje (%)

	3312
	1,78
	0
	0

	3208
	1,74
	0
	0

	3125
	1,71
	148
	18,95

	3005
	1,67
	172
	22,02

	2895
	1,63
	188
	24,07

	2793
	1,59
	212
	27,14

	2664
	1,54
	232
	29,71

	2512
	1,48
	256
	32,78

	2373
	1,42
	288
	36,88

	2207
	1,34
	316
	40,46

	2001
	1,25
	356
	45,58

	1840
	1,17
	388
	49,68

	1616
	1,06
	444
	56,85

	CONTINUACIÓN 

	1462
	0,98
	464
	59,41

	1218
	0,84
	524
	67,09

	998
	0,71
	568
	72,73

	820
	0,6
	604
	77,34

	616
	0,47
	652
	83,48

	394
	0,31
	704
	90,14

	199
	0,16
	744
	95,26

	5
	0
	781
	100


  	      Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015.
   	      Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


[bookmark: _Toc434503797][bookmark: _Toc436145008]Figura 21-2. Resistencia vs ciclo PWM.
Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


[bookmark: _Toc434503798][bookmark: _Toc436145009]   Figura 22-2. Voltaje vs ciclo PWM.
    Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
Conexión del controlador de motores paso a paso jp-382-a con arduino uno.

El controlador de motores paso a paso JP-382A es una placa que está construida a partir de los circuitos integrados TB6560AHQ, este tiene las siguientes características:

· RoHS/PBF/compatible sin plomo.
· Motor paso a paso circuito integrado.
· Fabricante: Toshiba, Geniune, no falsificación.
· Pico de corriente:  A.   
· Corriente nominal: 3A.
· Tensión de pico 40 V.
· Tensión nominal: 34 V.
· Micro-paso de Precisión: 1/2, 1/8, 1/16.
· Estabilidad chip: alta.

El controlador se comunica a través de un puerto paralelo y su diagrama de conexiones es el siguiente.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\diagram ardunio e easydriver.jpg]
[bookmark: _Toc434503799][bookmark: _Toc436145010]          Figura 23-2. Conexión del controlador de motores paso a paso.
                               Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Para la conexión del Arduino UNO con cualquier driver de motores paso a paso compatible, se tiene una imagen que muestra la distribución de los pines usados por el firmware GRBL (cargado anteriormente) para poder controlar los movimientos de la máquina.
[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\pine grbl_arduino.png]
[bookmark: _Toc434503800][bookmark: _Toc436145011]                                Figura 24-2. Pines de Arduino para GRBL.
                                                             Fuente: http://cnccontrol.byethost13.com

La imagen anterior consta de las funcionalidades que se le dan a cada uno de los pines del Arduino por medio del firmware mencionado. En nuestro caso no usamos todos los pines de conexión que nos brinda GRBL, a continuación, detallamos los que creímos necesarios para nuestro proyecto.

Dirección X-Axis: Pin que da la dirección para el motor del eje-X.
Dirección Y-Axis: Pin que da la dirección para el motor del eje-Y.
Dirección Z-Axis: Pin que da la dirección para el motor del eje-Z.
Step Pulse X-Axis: Pin que da el número de pasos para el motor del eje-X.
Step Pulse Y-Axis: Pin que da el número de pasos para el motor del eje-Y.
Step Pulse Z-Axis: Pin que da el número de pasos para el motor del eje-Z.
Limit X-Axis: Pin de conexión con final de carrera que indica el límite máximo del eje X. 
Limit Y-Axis: Pin de conexión con final de carrera que indica el límite máximo del eje Y.
Limit Z-Axis: Pin de conexión con final de carrera que indica el límite máximo del eje Z.
Reset/Aabort: Pin de conexión con el botón de paro de emergencia.

[bookmark: _Toc434503801][image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\driver jp.jpg]
[bookmark: _Toc436145012]      Figura 25-2. Partes del controlador de motores.
         Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

El controlador JP-382A se comunica a través de puerto paralelo como se puede notar en la imagen anterior, este puerto envía desde el ordenador personal en modo EPP, bits de funcionamiento que este controlador los interpreta con los TB6560AHQ, estos a su vez traducen esta información en movimientos de los motores paso a paso.  

Como este controlador solo trabaja con comunicación paralela, que en la actualidad los ordenadores no traen incluida, fue necesario cambiar la comunicación a USB que es muy común y que por muchos años más se mantendrá. En realidad este cambio de comunicación no fue muy difícil porque el Arduino con GRBL envía la información en bits que deben ser interpretados por el controlador.

La conexión es sencilla, los pines del puerto del controlador de los motores paso a paso son conectados a la placa Arduino UNO como se muestra en el siguiente diagrama de conexión.

[image: ]
[bookmark: _Toc434503802][bookmark: _Toc436145013]      Figura 26-2. Conexión de Arduino Y Controlador de motores.
                          Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

[bookmark: _Toc436145052]                                       Tabla 2-2. Descripción de pines de conexión.
	PINES (LPT)
	PINES ARDUINO
	DESCRIPCIÓN

	2
	2
	PASOS EJE X

	3
	5
	DIRECCIÓN EJE X

	4
	3
	PASOS EJE Y

	CONTINUACIÓN 

	5
	6
	DIRECCIÓN EJE Y

	6
	4
	PASO EJE Z

	7
	7
	DIRECCIÓN EJE Z

	10
	A0
	PARO

	18-25
	GND
	TIERRA (GND)


			Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015.
			Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Como podemos notar en la tabla anterior se indica cómo están conectados cada uno de los pines del puerto paralelo a la placa Arduino, dicha conexión se hace por medio de un cable db -25 como el que se muestra en la imagen siguiente.
	
[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\cable paralelo.jpg]
[bookmark: _Toc434503803][bookmark: _Toc436145014]                                     Figura 27-2. Cable db-25.
                Fuente: http://www.recycledgoods.com/computer-connecting-cables/

La comunicación entre el Arduino y el controlador JP-382A se realiza con los pines conectados a DIR Y STEP, el primero se encarga de enviar al controlador un pulso alto o un pulso bajo para determinar el sentido de giro de los motores paso a paso, este pin está conectado al pin CW del TB6560AHQ. 

De igual manera el pin STEP del Arduino se encuentra conectado al CLK del controlador, este pin es de microsteping que como lo dijimos anteriormente trabaja a 8 micro pasos, estos micro pasos se dan con una combinación de tiempo y pulsos altos. Para más información del controlador JP-382A, se puede revisar el datasheet del TB6560AHQ en el Anexo 3.

Para poder llevar a cabo la conexión del controlador de motores y la placa Arduino que sirve de interfaz de comunicación con la PC; se realizó una placa donde se ubica el Arduino uno y un conector dv-25 hembra, más los pines de conexión para los finales de carrera que se encargan de limitar el área de trabajo física de la máquina CNC los cuales no están incluidos en el controlador de motores JP-382A, pero que pueden ser conectados directamente al Arduino UNO.

[image: ]
[bookmark: _Toc434503804][bookmark: _Toc436145015]           Figura 28-2. Diseño de la placa de control
              		               Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

[image: C:\Users\JoseEnrique\Desktop\IMG_20151012_094722.jpg]
[bookmark: _Toc434503805][bookmark: _Toc436145016]               Figura 29-2. Placa de control terminada.
   			   Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

2.3.1.4. [bookmark: _Toc436063048]             Otros componentes varios


Instalación de los sensores finales de carrera

Los interruptores finales de carrera, como se explicó anteriormente son de gran importancia al momento de proteger la máquina de posibles daños ocasionados cuando el límite físico de los ejes se ha terminado. 

Fue necesario instalar 4 interruptores finales de carrera, dos en el eje X y dos en el eje Y; el eje Z no se consideró porque la distancia de recorrido es muy corta, al poner finales de carrera se limitaría aún más esta distancia. 

[image: C:\Users\JoseEnrique\Downloads\12186144_898710750178390_687285977_o.jpg]
[bookmark: _Toc434503806][bookmark: _Toc436145017]     Figura 30-2. Instalación de los sensores finales de carrera.
       	          Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Las conexiones de los finales de carrera se realizaron como si fueran simples pulsadores, con el objetivo de entregar un pulso alto o bajo al Arduino UNO. 

[image: ]
[bookmark: _Toc434503807][bookmark: _Toc436145018]                           Figura 31-2. Circuito de conexión 
          de los finales de carrera.
	              		Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
Botón de paro, ventilador y potenciómetro PWM.

El botón de paro de emergencia está conectado al controlador JP-382A, este botón se comunica por el pin 10 del puerto paralelo, que a su vez está conectado al pin A0 del Arduino UNO. 

El potenciómetro que regula el ciclo de PWM y el ventilador que ayuda como disipador de calor están incluidos en el diagrama de la tarjeta JP-1482, solamente se extendió con cables hasta la parte exterior del gabinete de control.
 
[image: C:\Users\JoseEnrique\Downloads\12180981_898997163483082_1325211457_o.jpg][image: C:\Users\JoseEnrique\Downloads\12185895_900134613369337_596583158_o.jpg]
[bookmark: _Toc434503808][bookmark: _Toc436145019]        Figura 32-2. Botón de paro y potenciómetro
                             Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


2.4. [bookmark: _Toc434485431][bookmark: _Toc436063049]                Mecánica de la máquina 


Como se especificó en nuestro anteproyecto la estructura de la máquina no sería de nuestro propio diseño. La idea es poder demostrar que el uso de software libre y algunos elementos electrónicos conocidos como el Arduino UNO, apoyados en una estructura aún básica de máquina CNC pueden llegar a tener resultados asombrosos en el fresado de placas de circuito impreso de gran precisión.
 

2.4.1. [bookmark: _Toc434485432][bookmark: _Toc436063050]             Elección de la estructura principal de la máquina CNC:


Al momento de elegir la estructura de nuestra máquina CNC tuvimos que tener en cuenta los siguientes aspectos:

· Precio: principalmente nuestro proyecto no puede ser excesivamente costoso, porque iría en contraste con el uso de software libre.

· Precisión: Nuestra máquina debe ser lo suficientemente precisa y exacta para poder realizar PCB de 0.2mm de precisión. Este aspecto es un poco más amplio, ya que esta precisión se consigue con una combinación de varillas roscadas y motor paso a paso en cada eje.

· Adaptabilidad a nuestros requerimientos: Teníamos que ser capaces de adaptar la máquina CNC a nuestro proyecto, esto significa que nuestro sistema debe ser totalmente confiable y tener varias seguridades que eviten problemas futuros con la máquina tanto en software como en hardware.

Después de un arduo trabajo de selección decidimos utilizar la máquina de escritorio CNC 3020T que se muestra en la siguiente imagen.

[image: 3020]
[bookmark: _Toc434503809][bookmark: _Toc436145020]              Figura 33-2. Máquina CNC 3020T.
              Fuente: http://www.marcmart.net/2012/02/16/manual-cnc-3020/


2.4.1.1. [bookmark: _Toc436063051]             Características principales:


· Dimensiones del área de trabajo: 200mm*300mm.
· Unidades de conducción de los ejes X Y Z: tornillos trapezoidales 1204.
· Materiales marco: aleación de aluminio 6063 y 6061 
· Tipo de motor paso a paso: 57 de dos fases 1.45A-2A ,1.8°.
· Pinza principal del eje: ER11 / 3,175mm. 
· Exactitud de repetición: 0.05mm. 
· Precisión del husillo: agudezas radiales de 0.03mm.  
· Interfaz de comunicación: a través de la conexión en paralelo con el ordenador.


2.4.2. [bookmark: _Toc434485433][bookmark: _Toc436063052]             Falla de la base de la máquina. 


Esta falla se refiere a que en primera instancia, la base de la máquina estaba desnivelada a causa de un defectuoso proceso de armado. No era posible fresar porque existía un excesivo nivel de error en la superficie de la máquina, motivo por el cual se presentaban segmentos de la PCB que ni si quiera eran alcanzado por la punta de la fresa y otros donde la profundidad era muy alta, ocasionando que la punta de la fresa se rompa.

La solución para tal error fue llevar la máquina a una rectificadora de motores donde ayudaron a nivelar la base con un palpador (dispositivo muy preciso), aún despues de este proceso la base quedó con una pequeña falla de 0.01mm a causa de que la base no estaba construída con una sola pieza si no en dos que se unen en el centro. 


2.4.3. [bookmark: _Toc434485434][bookmark: _Toc436063053]             MDF como base de fresado.


Se utilizó una madera de MDF con las mismas dimensiones del área de trabajo de la máquina, para usarlo como base de fresado por algunos motivos enlistados a continuación.

· Dar un acabado más estético de la máquina.
· Evitar que al perforar o cortar una PCB, se dañe la herramienta al topar con la estructura metálica.
· Contrarrestar el desnivel de la máquina.
· Facilitar el soporte de las baquelitas para que no se muevan al momento del fresado.
· Alzar la base de la máquina porque el husillo no alcanzaba a fresar la baquelita.

[image: C:\Users\JoseEnrique\Downloads\12193047_900338473348951_1562140737_o.jpg]
[bookmark: _Toc434503810][bookmark: _Toc436145021]                          Figura 34-2. Máquina CNC 3020T.
                                   		Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.




























[bookmark: _Toc434485435][bookmark: _Toc436063054]CAPÍTULO III




[bookmark: _Toc434485436][bookmark: _Toc436063055]3.                    PRUEBAS Y RESULTADOS:


[bookmark: _Toc434485437][bookmark: _Toc436063056]3.1.                 Cálculo del tamaño muestral


Es necesario demostrar el número de pruebas que se debe realizar en este trabajo de titulación, para esto es necesario aplicar conocimientos básicos de estadística para calcular el tamaño muestral.

Como primer paso consideramos el cálculo de la varianza previo a la obtención de tamaño muestral, y para obtenerlo se debe aplicar las siguientes formulas:

· Cálculo de la media





· Cálculo de la varianza


 

Si se desea conocer una cierta cantidad de muestras necesarias se debe conocer lo siguiente: 
a) El nivel de confianza o seguridad, este parámetro consiste en obtener un coeficiente según el nivel de confianza que se estime para el campo muestral, dicho coeficiente se lo obtiene haciendo unos cálculos mediante una gráfica como se ilustra en la figura. Para nuestro análisis optamos por escoger un nivel de confianza del 95%, con el mismo que nos arroja un coeficiente del 1.96.

b) La precisión que se desea obtener en el campo muestral.

c) La varianza es un dato muy primordial para tener una mejor estimación en el cálculo del campo muestral.  

Tomando en cuenta estos parámetros se puede obtener el campo muestral con la siguiente formula:  



 

[image: D:\Cristian\TESIS\calculo varianza.png]
[bookmark: _Toc434503811][bookmark: _Toc436145022]                Figura 1-3. Grafica para el cálculo del tamaño muestral.
	     Fuente: http://www.monografias.com/trabajos97

La interpretación de este resultado es que no hay necesidad de hacer un gran número de pruebas porque es una máquina que siempre realiza el mismo proceso. El resultado del trabajo de la máquina no depende de la precisión de esta, porque es precisa; el resultado de las placas talladas depende de la dimensión de la herramienta utilizada y de la profundidad de tallado. 

El objetivo es poder tallar placas con pistas de conducción de 0.2mm y la herramienta más fina es de 0.1mm. Se tomó la decisión de hacer cuatro pruebas para poder realizar algunos cálculos de errores y graficar estos datos. 


[bookmark: _Toc434485438][bookmark: _Toc436063057]3.2.                      Pruebas de comunicación entre software y hardware.


Estas pruebas son necesarias para saber si los elementos de control en la máquina tienen una comunicación sin problemas con el software. 


[bookmark: _Toc434485439][bookmark: _Toc436063058]3.2.1.                 Prueba de interruptores finales de carrera.


[image: C:\Users\JoseEnrique\Downloads\12186144_898710750178390_687285977_o.jpg]
[bookmark: _Toc434503812][bookmark: _Toc436145023]    Figura 2-3. Prueba de los sensores finales de carrera.
      Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Los interruptores finales de carrera están conectados directamente a la placa de control, para comprobar su correcto funcionamiento se envió un movimiento en el eje X/Y, mientras se ejecutaba el movimiento se activó manualmente uno de los finales de carrera para observar si el movimiento se detenía inmediatamente y el software respondía con su mensaje correspondiente.

Efectivamente el movimiento de los ejes fue interrumpido y el software respondió con el mensaje que se muestra en la imagen siguiente.

[image: ]
[bookmark: _Toc434503813][bookmark: _Toc436145024]                                          Figura 3-3. Mensaje de alarma del GRBL.
                                                          Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Esta prueba se realizó con cada uno de los 4 interruptores finales de carrera y el resultado fue el mismo. Motivo por el cual la máquina se encuentra bien protegida de posibles daños en los motores por esfuerzos que van más allá de los límites físicos.


[bookmark: _Toc434485440][bookmark: _Toc436063059]3.2.2.                Prueba de botón de paro de emergencia.


Al igual que la prueba anterior el botón de paro de emergencia debe hacer una función muy similar que los interruptores finales de carrera. Los movimientos de los ejes deben pararse inmediatamente pulsado el botón; si el operario nota alguna anormalidad en la ejecución del trabajo.

Probamos el funcionamiento de este botón en un movimiento y el programa nos devolvió el siguiente mensaje, que nos indica el correcto funcionamiento como se esperaba.

[image: ]
[bookmark: _Toc434503814][bookmark: _Toc436145025]                                               Figura 4-3. Prueba de botón de paro de 
                                                                   emergencia.
                                                                 Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
[bookmark: _Toc434485441][bookmark: _Toc436063060]3.3.                    Prueba de repetibilidad de movimiento con respecto a la velocidad.


Para esta prueba fue necesario la ayuda de un calibrador de precisión digital acoplado a el eje X de la máquina CNC, el cual se encargaba de tomar la medida del desplazamiento de dicho eje. El acople se muestra en la imagen siguiente.

[image: C:\Users\JoseEnrique\Downloads\12185859_898995340149931_386198447_o.jpg]
[bookmark: _Toc434503815][bookmark: _Toc436145026]               Figura 5-3. Repetibilidad de movimiento de los ejes con respecto a la velocidad.
                     Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Se envió por medio del GCODESENDER la orden de movimiento a diferentes velocidades, haciendo tres lecturas por cada velocidad escogida para sacar un promedio y poder graficar los datos obtenidos.

[bookmark: _Toc436145053]                      Tabla 1-3. Tabla de datos para determinar la estabilidad de la máquina.
	Velocidad mm/min
	Distancia(1)
Mm
	Distancia(2)
mm
	Distancia(3)
mm
	Distancia(p)
Mm

	40,00
	9,72
	9,71
	9.72
	9,72

	80,00
	9,75
	9,75
	9,74
	9,75

	100,00
	9,79
	9,79
	9,78
	9,79

	140,00
	9,84
	9,84
	9,82
	9,83

	180,00
	9,84
	9,84
	9,83
	9,84

	200,00
	9,84
	9,84
	9,83
	9,84

	250,00
	9,85
	9,85
	9,84
	9,85

	300,00
	9,86
	9,87
	9,86
	9,86

	CONTINUACIÓN 

	350,00
	9,88
	9,87
	9,85
	9,87

	400,00
	9,88
	9,89
	9,87
	9,88

	450,00
	9,89
	9,89
	9,88
	9,89

	500,00
	9,91
	9,90
	9,90
	9,90

	600,00
	9,91
	9,91
	9,90
	9,91

	700,00
	9,91
	9,92
	9,90
	9,91

	800,00
	9,93
	9,91
	9,90
	9,91

	900,00
	9,91
	9,92
	9,90
	9,91

	1000,00
	9,91
	9,91
	9,91
	9,91


                           Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015.
                           Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


[bookmark: _Toc434503816][bookmark: _Toc436145027]    Figura 6-3. Velocidad vs distancia.
     Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Al ver la figura 6-3 se puede notar que a velocidades bajas la máquina es muy inestable, mientras que a velocidades altas a partir de 500 mm/min empieza a estabilizarse. Hay que tomar en cuenta que como son medidas muy parecidas en décimas de milímetro, también pudo haber afectado el acople del calibrador con la máquina pero para una evaluación bastante aceptable los resultados son mas que satisfactorios.



[bookmark: _Toc434485442][bookmark: _Toc436063061]3.4.                   Prueba de profundidad de fresado en el eje Z.


Fue necesario realizar estas pruebas porque la calidad del fresado depende mucho de la profundidad a la que se haga, el punto cero del eje Z es cuando la herramineta toque la superficie de la baquelita. Esta calibración del eje Z se puede realizar de varias maneras:


[bookmark: _Toc434485443][bookmark: _Toc436063062]3.4.1.                Calibración de la herramienta


[bookmark: _Toc436063063]3.4.1.1.            Calibración por visión de operario


Esta calibración es la menos efectiva pero no deja de ser una calibración que se puede utilizar, para esto se debe bajar manualmene el eje Z girando el respectivo motor y observar que la punta de la fresa toque apenas la suerficie de la baquelita, como se puede ver en la siguiente imagen.

[image: C:\Users\JoseEnrique\Downloads\12190668_900327813350017_1075451318_o.jpg]
[bookmark: _Toc434503817][bookmark: _Toc436145028]                                    Figura 7-3. Calibración por visión del operario.
                                                  Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.




[bookmark: _Toc436063064]3.4.1.2.           Calibración por medio de continuidad


Esta calibración suele ser un poco mas efectiva que la anterior, para esta podemos usar un multímetro para medir la continuidad entre la fresa y la baquelita aprovechando que los dos tienen superficie metálica. Simplemente se conecta una punta del multímetro a la fresa y otra a la baquelita, posteriormente se baja el eje Z hasta que el multimétro emita un sonido y es entonces en ese momento que la punta de la fresa estará en el punto cero.

[image: C:\Users\JoseEnrique\Downloads\12194191_900327833350015_357280227_o.jpg]
[bookmark: _Toc434503818][bookmark: _Toc436145029] Figura 8-3. Calibración por medio de continuidad.
 	     Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


[bookmark: _Toc436063065]3.4.1.3.           Calibración por medio de un dispositivo de contacto y software


Esta sin duda es la calibración mas efectiva que se puede usar, existen en el mercado sondas de contacto que nos ayudan a calibrar el eje Z con mucha exactitud; es posible también diseñar una sonda de contacto, esto sería hacer un circuito donde la punta de la fresa y la baquelita se comporten como un interruptor y encender un led cuando este se cierre por el contacto.

Ya no se necesitaría mover manualmente el motor para bajar el eje Z, mas bien se utilizaría un movimiento por el software, enviando un movimiento de un paso hasta que la punta de la fresa toque la baquelita, luego apagar la máquina y guardar esta posición como origen.

[bookmark: _Toc436063066]3.4.2.             Prueba a 0.05mm


Una vez determinado el punto cero del eje Z, se envió a ejecutar un código donde se especificaba la profundidad de fresado en 0.05mm. Esta profundidad fue sin duda la que mejor resultado dió; la máquina pudo fresar sin problema la PCB sin que haya lugares donde no se eliminó el cobre por completo. El resultado fue el siguiente.

[image: C:\Users\JoseEnrique\Downloads\12182006_900312676684864_855495915_n.jpg]
[bookmark: _Toc434503819][bookmark: _Toc436145030] Figura 9-3. Prueba profundidad de fresado a 0.05mm.
                   Fuentes: CARRIÖN, Cristian, y GAIBOR, José, //2015.
	

[bookmark: _Toc436063067]3.4.3.             Prueba a 0.04mm 


En la siguiente prueba se utilizó una profundidad de fresado de 0.04mm, el resultado no fue el esperado porque quedaron lugares de la PCB sin fresar. Al obtener este resultado no conveniente se decidió que la profundidad exacta para el fresado es de 0.05mm. 

El problema por el cual la máquina no puede fresar a 0.04mm es ocasionado por la base de esta, estamos hablando de una diferencia de una centésima de milímetro entre las dos pruebas, un valor sumamente pequeño que a simple vista no es perceptible y que se refiere a una falla de fábrica de la máquina , como se explica en el capítulo anterior.

[image: C:\Users\JoseEnrique\Downloads\12202007_900312686684863_1416208811_n.jpg]
[bookmark: _Toc434503820][bookmark: _Toc436145031]Figura 10-3. Prueba de profundidad de fresado a 0.04mm.
                  Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


[bookmark: _Toc436063068]3.5.                   Prueba de fresado con fresa de 0.2mm a 10°


En esta prueba era necesario saber la precisión de fresado con pistas de conducción de 0.2mm de ancho, para esto se utilizó un diseño hecho en Proteus donde se le dio 8th que son aproximademante 0.203mm de ancho. 

[image: ]
[bookmark: _Toc434503821][bookmark: _Toc436145032]   Figura 11-3. Prueba de movimiento a 0.02mm a 10°.
    Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Una vez realizado el trabajo por la máquina, el siguiente paso era medir lo mas exacto posible el ancho real de las pistas de conducción fresadas. Para este propósito se utilizó el software Solidworks, donde se insertó una imagen de una fotografía en alta calidad, posteriormente se tomó dos medidas en partes estratégicas de la placa y se aplicó una regla de tres con una medida real conocida tomada con un calibrador digital de alta precisión, como se muestra en la imagen siguiente.

[image: C:\Users\JoseEnrique\Downloads\12185693_898600326856099_1133718215_o.jpg]
[bookmark: _Toc434503822][bookmark: _Toc436145033]   		  	Figura 12-3. Medición del fresado a 0.2mm con 
                                                             calibrador digital.
		 	Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Mediciones primer intento:

[image: ]
[bookmark: _Toc434503823][bookmark: _Toc436145034]   		              Figura 13-3. Medición del fresado a 0.2mm con 
                                                              Solidwoks.
		                   Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

En esta primera prueba las medidas fueron de 4.92mm y 190.31mm, la medida real es para todos 6.40mm. Al aplicar la regla de tres se obtiene.


Mediciones segundo intento:

[image: ]
[bookmark: _Toc434503824][bookmark: _Toc436145035]   		        	               Figura 14-3. Medición del fresado 
                                                                            a 0.2mm con Solidwoks.
			                     Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

En esta prueba al aplicar la fórmula anterior se obtiene lo siguiente.



Mediciones tercer intento:

En esta última prueba se aplicó la misma fórmula, dando como resultado un valor muy parecido.


[image: ]
[bookmark: _Toc434503825][bookmark: _Toc436145036]   	           Figura 15-3. Medición del fresado a 0.2mm con Solidwoks.
	 Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Mediciones cuarto intento.

El cuarto y último intento se realizó el mismo proceso anterior.



[image: ]
[bookmark: _Toc436145037]                         Figura 16-3. Medición del fresado a 0.2mm con Solidwoks.
	  Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Al obtener estos datos podemos notar que en promedio las mediciones del ancho de las pistas de conducción son de 0.1641mm siendo el valor que debía dejarse de 0.2mm.

Lo siguiente fue calcular algunos errores para poder interpretar los datos que se obtuvieron.

[bookmark: _Toc436145054]Tabla 2-3. Cálculo de errores absolutos y relativos.
	MEDIDAS(mm)
	ERRORES ABSOLUTOS
	ERRORES REALIVOS

	0.1655
	0.1655-0.1641= 0.0014mm
	(0.0014/0.1641)X100%=0.85%

	0.1610
	0.1610-0.1641=-0.0031mm
	(0.0031/0.1641)X100%=1.88%

	0.1651
	0.1651-0.1641=0.0010mm
	(0.0010/0.1641)X100%=0.61%

	0.1648
	0.1648-0.1641=0.0007mm
	(0.0007/0.1641)X100%=0.42%

	PROMEDIOS
	0.00155mm
	0.94%


Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Analizando los datos de errores que se obtuvieron podemos notar que la máquina tiene en promedio con las fresas de 0.2mm un error absoluto de 0.00155mm y un error relativo porcentual promedio de 0.94% que para nuestro proyecto va bastante bien.

En cuanto se refiere al valor deseado de 0.2mm de grosor de pistas de conducción notamos que la diferencia con el valor real es bastante amplia, pero hay que especificar que esto no se debe a causa de una imprecisión de la máquina; los motivos en realidad son porque se utilizó para esta prueba una fresa de 0.2mm de punta a 10°.

Las fresas son de tipo V, esto significa que el valor de 0.2mm está solamente en la punta de la fresa y como se especificó en la prueba de profundidad de fresado, el valor que baja el eje Z desde el punto cero es 0.05mm. Por tal motivo, fresar una pista de conducción de 0.2mm a una profundidad de 0.05mm en la baquelita es prácticamente imposible con una fresa de 0.2mm de punta. La forma de la fresa y lo explicado se puede apreciar de mejor manera en la siguiente imagen.

[image: C:\Users\JoseEnrique\Documents\ESPOCH\TESIS\imagenes_tesis\fresa v.jpg]
[bookmark: _Toc434503826][bookmark: _Toc436145038]   	                Figura 17-3. Nombres y forma de la fresa de 0.2mm
		    Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Con estos resultados se calculó una tabla de errores para analizar el funcionamiento del fresado a 0.2mm.

[bookmark: _Toc436145055]Tabla 3-3. Cálculo de errores absolutos y relativos.
	MEDIDAS(mm)
	ERRORES ABSOLUTOS
	ERRORES RELATIVOS

	0.1655
	0.2-0.1655= 0.0345mm
	(0.0345/0.2)X100%=17.25%

	0.1610
	0.2-0.1610=0.0390mm
	(0.0390/0.2)X100%=19.5%

	0.1651
	0.2-0.1651=0.0349mm
	(0.0349/0.2)X100%=17.45%

	0.1648
	0.2-0.1648=0.0352mm
	(0.0352/0.2)X100%=17.6%

	PROMEDIOS
	0.0361mm
	17.95%


Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015.

El cálculo de errores permitió interpretar que el porcentaje de error relativo en el fresado a 0.2mm es de 17.95% en promedio que es un valor bastante aceptable si se toma en consideración que las medidas requeridas son en decimas de milímetro.


[bookmark: _Toc436063069]3.6.                   Prueba de fresado con fresa de 0.1mm a 10°


Como en la prueba anterior con fresa de 0.2mm obtuvimos un error de 17,95%, para reducir este valor utilizamos una fresa de 0.1mm; hay que aclarar que la fresa utilizada no tiene este diametro de punta de fábrica, fue necesario lijar la punta de una fresa de diametro mayor, dejándola lo más próxima 0.1mm, como se muestra en la siguiente imagen.

[image: C:\Users\JoseEnrique\Downloads\12218356_903707446345387_1706932446_o.jpg]
[bookmark: _Toc436145039]     Figura 18-3. Fresa lijada con punta aproximada de 0.1mm.
                         Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Mediciones primer intento

Se usó el mismo método de medición de la prueba anterior con la ayuda de Solidworks. Los datos obtenidos fueron relacionados con la siguiente ecuación.


[image: ]
[bookmark: _Toc436145040]     Figura 19-3. Medición primer intento con fresa de 0.1mm. 
       Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Como resultado fue una medida de 0.2020mm de ancho de la pista de conducción.

Mediciones segundo intento

Aplicando la misma ecuación con las dimensiones tomadas en el segundo intento se obtuvo un valor de 0.2003mm.
 

[image: ]
[bookmark: _Toc436145041]           Figura 20-3. Medición segundo intento con fresa de 0.1mm. 
                                                  Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Mediciones tercer intento

De la misma manera se calculó el valor de la medida de la pista de conducción obteniendo una medida de 0.2018mm.



[image: ]
[bookmark: _Toc436145042]            Figura 21-3. Medición tercer intento con fresa de 0.1mm. 
                                                    Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.



Medición cuarto intento

El cuarto y último intento nos dio un valor muy parecido a los anteriores y se muestra a continuación.


 
[image: ]
[bookmark: _Toc436145043]           Figura 22-3. Medición cuarto intento con fresa de 0.1mm. 
                                                  Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.

Una vez tomadas todas las muestras, lo siguiente fue calcular algunos errores absolutos y relativos como en la prueba anterior para analizar los resultados de mejor manera. 

Primero se calculó errores con respecto a la repetibilidad de precisión en el tallado, haciendo un a comparación de las 4 medidas tomadas que dieron una media de 0.2012mm. 

Con los resultados después del cálculo se puede afirmar que el error de repetibilidad de fresado de placas es mínimo, como en la prueba con fresas de 0.2mm.; en este caso el valor de error fue de 0.34% que se traduce a un excelente funcionamiento de la máquina CNC y dejando la posibilidad de poder hacer placas en serie. 

Los cálculos y resultados se muestran en la siguiente tabla.

[bookmark: _Toc436145056] Tabla 4-3. Cálculo de errores absolutos y relativos.
	MEDIDAS(mm)
	ERRORES ABSOLUTOS
	ERRORES REALIVOS

	0.2020
	0.2020-0.2012= 0.0008mm
	(0.0008/0.2012)X100%=0.39%

	0.2003
	0.2003-0.2012=-0.0009mm
	(0.0009/0.2012)X100%=0.45%

	CONTINUACIÓN 

	0.2018
	0.2018-0.2012=0.0006mm
	(0.0006/0.2012)X100%=0.30%

	0.2008
	0.2008-0.2012=-0.0004mm
	(0.0004/0.2012)X100%=0.20%

	PROMEDIOS
	0.00068mm
	0.34%


Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015.

El siguiente paso fue calcular errores con respecto al valor deseado de ancho de pista de conducción eléctrica. Como se explicó en la prueba anterior se utilizó el modelo creado en Proteus donde se dio un valor de 0.2030mm en el ancho de la pista de conducción. 

Los resultados obtenidos fueron en promedio un error absoluto de 0.0018mm y un error relativo porcentual de 0.86%. Se puede concluir con este resultado menor al 1%, que el objetivo principal de este trabajo de titulación fue cumplido a cabalidad. Los resultados se muestran en la tabla 5-3.

[bookmark: _Toc436145057]Tabla 5-3. Cálculo de errores absolutos y relativos.
	MEDIDAS(mm)
	ERRORES ABSOLUTOS
	ERRORES RELATIVOS

	0.2020
	0.2030-0.2020= 0.0010mm
	(0.0010/0.2030)X100%=0.49%

	0.2003
	0.2030-0.2003=0.0027mm
	(0.0027/0.2030)X100%=1.33%

	0.2018
	0.2030-0.2018=0.0012mm
	(0.0012/0.2030)X100%=0.60%

	0.2008
	0.2030-0.2008=0.0022mm
	(0.0022/0.2030)X100%=1.08%

	PROMEDIOS
	0.0018mm
	0.86%


Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.
Realizado por: CARRIÖN, Cristian, y GAIBOR, José, //2015.


[bookmark: _Toc436063070]3.7.                   Otros Resultados de Fresado.


Se probó un fresado de la placa Arduino nano, en este caso la cara top que está disponible en la página oficial de Arduino. Estas están diseñadas en Eagle, se obtuvo el archivo gerber de este diseño y se fresó en la máquina CNC; el diseño y el resultado se muestra en la siguiente imagen.


[image: ]
[bookmark: _Toc436145044]                           Figura 23-3. Placa Arduino nano (diseño y fresado)
		  Fuente: CARRIÖN, Cristian, y GAIBOR, José, //2015.


[bookmark: _Toc436063071]CONCLUSIONES 


· Seleccionar la estructura mecánica de una máquina CNC modelo 3020T, considerando los parámetros más importantes como: el paso de la rosca del husillo, los pasos por revolución de los motores paso a paso aseguró conseguir una precisión de 0.2mm de fresado gracias a la buena resolución de movimiento de los ejes.

· Al investigar los diferentes procesos que pueden realizarse con una máquina CNC, así como los diferentes materiales en los que puede realizar el fresado, se determinó el correcto algoritmo a seguir para el diseño y construcción de nuestro prototipo puliendo los diferentes procesos para lograr un maquinado de trabajo preciso y conciso, acorde a las necesidades requeridas por los usuarios.

· El uso del JP-382A brindó la capacidad de soportar el pico máximo de corriente de los motores paso a paso de los tres ejes de la máquina; también la utilización del controlador JP-1482 para el control de PWM del husillo, la rectificación de la corriente de alimentación de todo el sistema y la regulación de voltajes para los diferentes dispositivos en el gabinete de control, no dejaron de ser menos importantes.

· El software libre FLATCAM, convierte los archivos gerber generados por el software de diseño de PCB a código G, pues brinda una potente plataforma adaptable a nuestras necesidades, mejorando la calidad del resultado final del fresado, puesto que la generación de código G influye directamente en la traducción de este código a instrucciones realizadas por el software GRBL encargado de controlar los movimientos globales de la máquina.

· Para que la placa Arduino UNO pueda interpretar código G, se cargó el software GRBL. El funcionamiento correcto de este, necesita de configuraciones realizadas por medio de comandos $$ en todos los parámetros mecánicos, eléctricos y electrónicos que GRBL debe conocer para que los ejes de la máquina se muevan de forma correcta en las trayectorias a seguir para la realización de las pistas en la PCB.


· La estructura mecánica de la máquina CNC modelo 3020T, junto con el software de alto nivel GRBL y el uso de la fresa correcta, hacen que el fresado de PCB’s con pistas de conducción eléctrica de 0.2mm de ancho, sea realizado correctamente; permitiendo que el resultado final este apto para el montaje de elementos electrónicos SMD.

· Durante la comprobación de los resultados del fresado a 0.2mm, se pudo notar que la máquina cumple con los requerimientos, con un error mínimo totalmente aceptable en la fabricación de placas PCB.



























     

[bookmark: _Toc436063072]RECOMENDACIONES


· Revisar que el punto de origen de la máquina este ubicado de tal manera que tenga espacio suficiente para poder realizar la PCB y no llegue a los límites finales de carrera, ocasionando el paro inmediato del trabajo.

· Para fijar la baquelita en la base de la máquina es necesario utilizar cinta doble faz cubriendo toda el área de la baquelita, con el objetivo de no tener desnivel en la misma y que no se mueva de su posición mientras la máquina realiza el fresado. La función de la cinta doble faz fue probado con un resultado muy satisfactorio, ya que se adhiere con facilidad a la base de MDF.

· El tiempo de fresado de la máquina no debe exceder a 20 minutos como límite porque los motores se calientan excesivamente; si el fresado de la PCB no ha terminado aún, se puede pausar el proceso a través de GCODESENDER y apagar la caja de control por un lapso de tiempo prudente hasta que los motores se enfríen; luego de esto se puede continuar con el fresado. De esta manera aseguramos una larga vida útil de los motores que son fundamentales en la máquina.       

· Para las puntas de fresa finas de 0.1mm y 0.2mm de diámetro se recomienda utilizar una velocidad de fresado no mayor a 80mm/min. Esta velocidad se puede especificar al momento de crear el código G en el software FLATCAM.

· Tener en cuenta que las revoluciones del motor que sujeta la herramienta debe estar a un 75% del ciclo del PWM, porque si está a una velocidad menor ocasiona un gran desgaste o rotura de la fresa.

·  Para el tallado de placas PCB con líneas de conducción de 0.3mm se debe utilizar fresas con un diámetro menor, para lograr una excelente precisión de fresado.

· Realizar bien la sujeción de la fresa en el portaherramientas, ya que si no se encuentra bien sujeta puede causar imperfecciones en el tallado del PCB, es decir no se obtiene el ancho de las líneas de conducción que se desean.
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MANUAL DE USUARIO “FLATCAM”

1. INTRODUCTION

FlatCAM is a program for preparing CNC jobs for making PCBs on a CNC router. Among other things, it can take a Gerber file generated by your favorite PCB CAD program, and create G-Code for Isolation routing.

2. INSTALLATION

2.1. WINDOWS INSTALLER

Download the installer from the repository and run it in your machine. It includes everything you need.

2.2. UBUNTU

FlatCAM should work on most Linux distributions but Ubuntu has been chosen as the test platform.

There are several dependencies required to run FlatCAM. These are listed in the following section. Before attempting a manual installation, try running the provided setup script setup_ubuntu.sh that will download and install required packages.

2.3. OS-X

See manual instructions below.

2.4. MANUAL INSTALLATION

2.4.1. Requirements

•	Python 2.7 32-bit
•	PyQt 4
•	Matplotlib 1.3.1
•	Numpy 1.8
•	Shapely 1.3
· GEOS
· RTree
· SpatialIndex

These packages might have their own dependencies.

2.4.2. Linux

Under Linux, most modern package installers like yum or apt-get will attempt to locate and install the whole tree of dependencies for a specified package automatically. Refer to the provided setup script setup_ubuntu.sh for the names and installation order.
Once the dependencies are installed, download the latest .zip release (or the latest source, although it is not garanteed to work), unpack it, change into the created folder and run:

Python FlatCAM.py

2.4.3. Windows

An easy way to get the requirements in your system is to install WinPython. This is a standalone distribution of Python which includes all of FlatCAM’s dependencies, except for Shapely and RTree. These can be found here: Unofficial Windows Binaries for Python Extension Packages.
Once the dependencies are installed, download the latest .zip release (or the latest source, although it is not garanteed to work), unpack it, change into the created folder and run:

Python FlatCAM.py

2.4.4. OS-X

Start by installing binary packages: pyqt, geos, spatialindex. One way to do this is using Homebrew:

Brew install name_of_package

Now you can install all Python packages (numpy, matplotlib, rtree, scipy, shapely, simplejson) using pip:

Pip install name_of_package
Finally, download the latest FlatCAM .zip package or source code. Change into its directory and launch it by running:

Python FlatCAM.py

3. BASICS

3.1. SOURCE FILES

Supported source files are:

•	Gerber: Typically define copper layers in a circuit board.
•	Excellon: (drill file): Contain drill specifications, size and coordinates.
•	G-Code: CNC machine instructions for cutting and/or drilling.

These source files can be loaded by selecting File→Open Gerber…, File→Open Excellon… orFile→Open G-Code… respectively. The objects created from source files are automatically added to the current project when loaded.

3.2. OBJECTS AND TASKS

Data in FlatCAM is in the form of 4 different kinds of objects: Gerber, Excellon, Geometry and CNC Job. Gerber, Excellon and CNC Jos objects are directly created by reading files in Gerber, Excellon and G-Code formats. Geometry objects are an intermediate step available to manipulate data. The diagram bellow illustrates the relationship between files and objects. The arrows connecting objects represent a sub-set of the tasks that can be performed in FlatCAM.

[image: _images/objects_flow.png]
3.3. CREATING, SAVING AND LOADING PROJECTS

A project is everything that you have loaded, created and set inside the program. A new project is created every time you load the program or run File→New.

By running File→Save Project, File→Save Project As… or File→Save a Project Copy… you are saving everything currently in the environment including project options. File→Open Project… lets you load a saved project.

3.4. NAVIGATING PLOTS

Plots for open objects (Gerber, drills, g-code, etc…) are automatically shown on screen. A plot for a given can be updated by clicking “Update Plot” in the “Selected” tab, in case any parameters that would have changed the plot have been modified.

Zooming plots in and out is accomplished by clicking on the plot and using the mouse scroll wheel or hitting one of the following keys:

•	1: Fits all graphics to the available plotting area.
•	2: Zooms out
•	3: Zooms in

When zooming in or out, the point under the cursor stays at the same location. To scroll left-right or up-down, hold the shift or control key respectively while turning the mousescroll wheel.

4. COMMON PROCEDURES

This chapter is a tutorial-style introduction to the most common operation in FlatCAM.

4.1. ISOLATION ROUTING

Isolation routing is the operation of cutting copper around traces for electrical isolation. For details see the Isolation Routing section in the Gerber Object reference.

1.	Open a Gerber file: File→Open Gerber…
The file is automatically analyzed, processed and plotted.
2.	Enter the diameter of the tool you will use for isolation routing and hit “Generate.
Geometry”. The units are determined by the project setting and are shown on the bottom right of the screen. If you want to work using different units, go to Options, Project Options (Combo box), Units. This will change the units for the whole project.

[image: _images/open_gerber_ready.png]

This creates a new geometry object listed under “Project” with the same name as the Gerber object with an “_iso” postfix, and its options are shown in “Selected”. Zoom into the plot (click over the plot and use the 2 and 3 keys to zoom in and out) to inspect the results.

[image: _images/iso_routing_ready.png]

3.	Create a CNC job from the new geometry by indicating the desired parameters as shown in the figure above and explained below:
Cut Z: The depth of the tool while cutting. -2 mils or -0.05 mm are a typical value for isolation routing.

1. Travel Z: The height above the board at which the cutting tool will travel when not cutting copper.

2. Feedrate: The speed of the cutting tool while cutting in inches/minute of mm/minute depending on the project settings.

3. Tool diam.: The cutting tool diameter. Use the same value as when creating the isolation routing geometry in step 2.

A CNC Job object has been added to your project and its options are shown in the “Selected” tab. Tool paths are shown on the plot. Blue are copper cuts, while yellow are travelling (no cutting) motions.

[image: _images/iso_routing_cnc_ready.png]
 
Click on the “Export” button under “Export G-Code”. This will open a dialog box for you to save to a file. This is the file that you will supply to your CNC router.

4.2. WIDE ISOLATION ROUTING




Note

This description is obsolete. In the current version of FlatCAM, isolation routing with multiple tool width is automatically calculated.

1. Go to the Project tab and double-click on the isolation geometry object that you created for the 1st pass. In the Selected tab, change its name and hit Enter.
2. Go back to Project and double-click on the Gerber object. This takes you back to step 1 of tutorial 4.1. We will generate geometry for a second pass in the same way but with a larger offset. If Tool diam reads 0.016, enter 0.016*2.5 instead (0.016*3 would put the path 3 times as far which provides no overlap with the previous pass. By setting it to 0.016*2.5 you ensure that there is no copper left on the board and a cleaner finish). Click on Generate Geometry just like in tutorial 4.1 and you should get something like the figure below.

[image: _images/Double_iso.png]

3. Generate a CNC job like you did in part 3 of tutorial 4.1. You will end up with 2 G-Code files, one for each pass.

4.3. CNC JOBS FOR DRILL FILES
For details see the Excellon Object reference section.

1. Open a drill (Excellon) file: File→Open Excellon. The drill file will be drawn onto the plot and its options form should show up.

2. A drill file will usually contain different tools (drill diameters). You can choose to create a CNC job for each individual tool or bundle some of the tools together in the same job (in case you did not intend to use drill bits of different diameters). Click on Choose under Create CNC Job to open a selection window with the list of tools. Each has the format id: diameter, where the diameter is in the project’s units. Check the boxes by the tools you want to include in the job. The comma-separated list of tools should appear in the Tools entry box (Note: If you know the ids of the tools you can type the list yourself).

[image: _images/drill_tool_select.png]

Note

UPDATE: In the current version of FlatCAM, the tool list is automatically shown and the user can no longer type the desired list of tool. The selection is made directly on the list.

3. Adjust Drill Z (Drilling depth), Travel Z (Height for X-Y movement) and Feed rate (Z-axis speed in project units per minute) to your desired values, and click on Generate.

[image: _images/drill_cnc_job.png]

A CNC job will be created and the tool-path will be shown on the screen. Click on Export G-Code as explained in tutorial 4.1 to save the generated CNC job to G-Code.

4.3. 2-SIDE PCB

The main idea behind this process is to ensure that when you turn your board around to mill the bottom side of your PCB it will be perfectly aligned with the top side.

The mechanical alignment is accomplished by using alignment holes/pins. These are holes on your board and on the milling machine bed (typically a board of wood, known as “sacrificial” layer). Pins are used to align the holes on the board to the holes on the sacrificial layer. The holes are always pairs of holes that are symmetrical about a mirror axis. This ensures that when you turn your board around, the board can be aligned using the same alignment holes as before.

[image: _images/double1.png]

The bottom layer must be flipped (mirrored) around the same axis that was used for the alignment holes.

The placement of the mirror axis can be totally arbitrary. You just need to make sure that after flipping the board around, it will still fit on the milling machine bed. Same for the alignment holes. It doesn’t matter much where you put them. Perhaps if you have a large bare copper board and you plan on reusing the alignment holes for different projects that will be made out of this same bare board, you might want to define the location of the axis and holes, and record them for later use.

FlatCAM takes care of the rest. To ensure the symmetry of the alignment holes, FlatCAM asks you to specify the holes on only one side of the mirror axis and it will create the mirror copies for you. It will also mirror the bottom (Gerber) layer around the same axis.

[image: _images/double2.png]

The process of making the double-sided board consists of creating the CNC Job Object for the top layer, the mirrored bottom layer and the alignment holes using FlatCAM. Then you can run the alignment holes job (you must drill through the board and into the sacrificial layer) and the top layer job. You must then turn the board around, align it using the alignment holes (fit some kind of pin in the holes) and run the bottom layer job.

Here is how to use FlatCAM to generate the required files:

1. Open the Gerber files for the top and bottom layers of your PCB.

2. Start the Double-sided PCB T by selecting Tools→Double-sided PCB tool.
[image: _images/dbl_sided1_arrows.png]

The tool has the following options:

•	Bottom Layer: Indicates which layer is the bottom layer, which needs to be flipped.
•	Mirror axis: Around which axis, X or Y, we want to mirror the layer.
•	Axis location: How we want to specify the location of the axis.
•	Point/Box: Specifies the location of the axis. It depends on the Axis location setting:
· Point: A single point specifies where the axis is, and you input the coordinates of the point in the format (x, y). For example, if Mirror Axis is set to X and Point is set to (1.0, -1.0) the axis will be horizontal at y=−1.0 (The x coordinate is ignored).
· Box: If you have already defined the boundary of your PCB you may want the axis to be exactly in the middle of that rectangle. The boundary must be some geometry object defined in the project and can be selected in the combo box appearing in the Point/Box field.
•	Alignment holes: These can aid in placing the board at the exact position after turning it over for the bottom side job. These holes must be symmetrical to the mirror axis. You only need to specify the location of the holes on one side of the mirror axis and the program will create the mirror copy. Input the coordinates of the holes in the following format: (x1, y1), (x2, y2), etc.
•	Drill diameter: The diameter of the drill for the alignment holes.

Note

You don’t have to manually type coordinates of points. Clicking on the plot automatically copies the coordinates to the clipboard in (x, y) format and these can be pasted into the input boxes.

3. Create the mirror image of the bottom layer by clicking on Create Mirror. This will create a new Gerber object for the project. You can work with this object, create isolation routing and a CNC job as it has been show in the previous tutorials. You may want to hide or remove the layer for the top side to ease the visualization.

4. Create the alignment hole drill object by going back to the Double-sided PCB tool and clickingCreate alignment drill. This will create an Excellon Object (drill job) as specified and a CNC Job Object can be created for it as has been shown for the previous examples.
 
[image: _images/bottom.png]

4.5. COPPER AREA CLEAR

For details see the Paint Area section in the Geometry Object reference.

Removing large areas of copper is necessary when trying to avoid shorts due to dust, rust, etc, or in RF circuits, where the remaining unused copper is just unwanted parasitics. This tutorial shows how to eliminate all copper that is not specified in the Gerber source, while still being able to selectively choose what to clear.
[image: _images/coppercleardemo1.png]

1. Open a Gerber file as explained in previous tutorials.

2. In the Selected tab for the Gerber Object, under Non-copper regions, provide Boundary Marginand click Generate Geometry. This creates a new Geometry Object containing a bounding box around the Gerber object, with the given margin. Then subtracts the Gerber object from the bounding box, resulting in a Geometry object with polygons covering the areas without copper.
[image: _images/coppercleardemo2.png]

3. Now we can choose which polygon we want to “paint”, this is, draw a tool path inside it to cover all its surface. In the Selected tab for the newly created Geometry Object, under Paint Area, provide the following:

· Tool diam.: The diameter of the tool that will be used to cut the area.

· Overlap: Fraction of the tool diameter by which to overlap each passing cut. The default value of 0.15 is the minimum to ensure no copper is left in 90 degree turns of the tool path.

· Margin: Distance for the tool to stay away from the polygon boundary. This can be used to ensure that a large tool does not touch copper edges that have or will be cut by a smaller more precise tool.

· Click on Generate and then click on the plot inside the polygon to be painted. This will create a new Geometry Object with the desired tool paths.
[image: _images/coppercleardemo2.png]

4.6. BOARD CUTOUT

To cut the PCB to the desired shape and remove it from a larger blank PCB, a tool path that traces the board edge can be created. Gaps to hold the board until the job is complete can be placed along the edge.

This tutorial describes how to create rectangular cutouts with 2 or 4 gaps.

1. Open a Gerber file and find the Board Cutout section in the Selected tab.

[image: _images/cutout_form.png]

2. Specify a Margin. This will create a rectangular cutout at the given distance from any element in the Gerber. Specify a Gap Size. 2 times the diameter of the tool you will use for cutting is a good size. Specify how many and where you want the Gaps along the edge, 2 (top and bottom), 2 (left and right) or 4, one on each side. Click on Generate Geometry. The figure below shows an example of the results.

[image: _images/cutout2.png]

3. Create a CNC job for the newly created geometry as explained in earlier tutorials.

[image: _images/cutout3.png]
 
Note

Board cutouts of arbitrary shape and arbitrary number, location and size of gaps are possible. Visit the program’s web page for examples and tutorials.




4.7. BED FLATTENING

Most often a sacrificial layer (e.g. wood) is used between the machine bed and the PCB so when drilling and cutting the machine is not hit by the tool. In order to have a completely flat surface for the PCB, the sacrificial layer is flattened by the machine. This tutorial shows how to create a tool path for this purpose.

1. Open a Gerber file and locate the Bounding Box section in the Selected tab.
2. Specify a Margin (distance of the bounding box from any element in the Gerber) and whether you want rounded corners. Click Generate Bounding Box.

[image: _images/bedflatten0.png]

Make sure your blank PCB will fit in the bounding box.

[image: _images/bedflatten.png]

3. In the Selected tab for the newly created geometry locate the Paint Area section. Specify thediameter of the tool you will use, how much (fraction of the tool width) each pass will overlapeach other, and a Margin (although typically not needed and set to 0.0 in this case.).

[image: _images/bedflatten1.png]

4. Click on Generate, and you will be asked to click inside the polygon inside which to create the tool path. Click inside the boundary we just created.

[image: _images/bedflatten2.png]

5. Create a CNC job for the newly created geometry as explained in earlier tutorials.

Note

Bed flattening of arbitrary shape are possible. Visit the program’s web page for examples and tutorials.

5. OBJECT REFERENCE

FlatCAM Objects are the documents FlatCAM operates with. For an introduction see Objects and Tasks.

5.1. GERBER OBJECT

5.1.1. Format

The Gerber Format specifies polygons. Shapes that have an area. Most commonly copper regions in a specific layer of a PCB. It is also used for solder masks, solder paste and artwork.
A short Gerber file looks like this:
G04 This line is a comment an is ignored.*
G04 Coordinate format specification:*
%FSLAX25Y25*%
G04 Set units to inches:*
%MOIN%
G04 Define an aperture:*
%ADD10C, 0.100*%
G04 Change polarity to DARK:*
%LPD*%
G04 Select the the previously defined aperture:*
D10*
G04 Set interpolation mode to linear:*
G01*
G04 Move to (0, 0) without drawing:*
X0Y0D02*
G04 Draw to (5, 5) using aperture 10:*
X500000Y500000D01*
G04 Enf of file:*
M02*

5.1.2. Support

The Gerber File Format is fully supported with the following exceptions as of version 8.2:

•	Holes in standard apertures are not supported.

•	Interpolation is always done with a circular aperture even if a non-circular aperture is chosen. An equivalent size is calculated from the dimensions of the aperture and used as the diameter of a circular aperture. This is unlikely to ever affect a gerber for a PCB. This limitation does not affect flashing.

•	Step and Repeat (SR) is not supported.

5.1.3. Creation

Gerber Objects are created by opening a Gerber File. This can be done via:

•	The File→Open Gerber menu option
•	The File→Open Recent menu option
•	The open_gerber command in the Shell Command Line Interface.

5.1.4. Operations

5.1.4.1. Isolation Routing

Parameters:

•	Tool dia d: The diameter of the cutting tool.
•	Width (# passes) n: Width if the isolation gap in number of tool diameters.
•	Pass overlap θ: Fraction of the tool diameter to overlap each pass.

Generates a Geometry Object describing the tool path to cut outside the perimeter of the polygons described in the Gerber file. The first tool path is at a distance D=d/2 outside the polygon. If n>1 then there will be n−1 additional tool paths at a distance D=d(1−θ) from the previous pass.
Isolation routing is available in the GUI and via the isolate command in the Shell Command Line Interface.

[image: _images/iso.png]
Isolation Routing example with n=2.

5.1.4.2. Board Cutout

Parameter:

•	Tool dia d: The diameter of the cutting tool.
•	Margin m:
•	Gap size g:
•	Gaps: Takes the following possible values:

· 2 (T/B): Two gaps, at top and bottom sides.
· 2 (L/R): Two gaps, at left and right sides.
· 4: Gaps on all 4 sides.

Generates a Geometry Object with a rectangular tool path around the geometry in the Gerber Object. The tool path includes gaps that will prevent the board being cut from completely detaching from the parent board while cutting.

The Board Cutout operation is available in the object’s GUI or via the cutout command in the Shell Command Line Interface.
 
Board Cutout operation dimensions.

5.1.4.3. Non-copper Regions

Parameters:

•	Boundary Margin m: Distance from the smallest possible bounding box.
•	Rounded Corners:

Generates a Geometry Object with polygons of the empty areas in the Gerber Object, this is, where there is no copper.

[image: _images/non_copper.png]

Non-copper region generation. (a) Example with zero margin. (b) Example with non-zero margin.
The Non-copper Regions operation is available through the object’s GUI.


5.1.4.4. Bounding Box

Parameters:

•	Boundary Margin m: Distance from the smallest possible bounding box.
•	Rounded Corners: If set, then the corners will be rounded with a radius m.

Generates a Geometry Object with a rectangular path around the geometry in the Gerber Object at a distance m from the smallest possible bounding box. If using rounded corners, their curvature radius will also be m.

[image: _images/bounding_box.png]

Bounding box generation for Gerber Objects. (a) Without rounded corners. (b) With rounded corners.

The Bounding Box operation is available through the object’s GUI.

5.1.4.5. Scale

Parameters:

•	Factor k: Factor by which to multiply the geometric features of the object. Example: 2.54.
Modifies the Gerber Object by changing its dimensions. The geometry in the Gerber Object is multiplied by the given factor. E.g. if factor is k=2, the geometry will be doubled in size. Consequently, any coordinate point that was originally at a distance d from the origin, will be at 2d.

The scale operation is available in the GUI and via the scale command in the Shell Command Line Interface.

5.1.4.6. Offset

Parameters:

•	Vector v: Coordinate pair by which to translate the geometric features of the object. Example:(1.0, -2.0).

Modifies the Gerber Object by translating its coordinates. All coordinates in the Gerber Objects are added to the given vector. I.e. if v= (xv, yv) then all points (x,y) will be translated to (x+xv,y+yv).

The offset operation is available in the GUI and via the offset command in the Shell Command Line Interface.

5.1.4.7. Follow

Note

The Follow operation is not fully functional yet. For an overview on how it currently operates, visit the blog post Tracing the Silkscreen with FlatCAM.

5.1.4.8. Mirror

Parameters:

•	Mirror Axis: Axis around which to mirror the object’s geometry. I.e. X or Y.
•	Axis Location: The location of the mirror axis can be specified in one of two ways:

· A Point through which the the axis passes. E.g. (1.0, -2.0), then if the axis is X then it is a horizontal line passing through y=−2.0. If it’s the Y axis, it is a vertical line passing through x=1.0. This option is only available in the Double-Sided PCB Tool.
· A Rectangle which is divided by the axis in half. In this case, a Geometry Object containing a single rectangle is specified.

Mirrors the geometry in the object around a specified axis.

This operation is available via the Double-Sided PCB Tool (see 2-side PCB) and the mirror command in the Shell Command Line Interface.

5.2. EXCELLON OBJECT

5.2.1. Format

The Excellon File Format specifies how a circuit board should be drilled.

Excellon files are text files with tools and holes directives. An short Excellon file looks like this:

; This line is a comment and is ignored
; The next line starts the "header":
M48
; Units and number format:
INCH,LZ
; One tool is defined with diameter 0.04 inches,
; drill rate of 300 inches/minute and 55000 RPM.
T1C.04F300S55
; End of header, M95 or %, and beginning of body:
M95

; Use tool 1 defined in the header
T1
; Drill at points (123.45, 234.5) and (12.345, 234.5):
X12345Y23450
X012345Y234500
; End of program;
M30

Unfortunately, the format is not very well specified and there is room for ambiguity. Several CAD programs will implement the format incorrectly making it impossible to interpret as intended. FlatCAM attempts to follow the original specification as strictly as possible and defaults to the following values when not clearly specified in the file:



5.2.2. Support

•	FlatCAM only supports drilling. Routing directives in Excellon are not supported.
•	The default units are INCHES.
•	Number format is 000.000 for millimeters and 00.0000 for inches.
•	Zero format is Leading. If less than 6 digits are provided, they are added by FlatCAM to the right of the number. Leading zeros are assume present.
•	Tool definitions in the body (After M95) are not supported.

5.2.3. Overriding defaults

To override the zeros format default, set the system parameter excellon_zeros in the Shell Command Line Interface:

set_sys excellon_zeros T

5.2.4. Creating Excellon Objects

Excellon Objects are created by opening an Excellon file:

•	The File→Open Excellon menu option
•	The File→Open Recent menu option
•	The open_excellon command in the Shell Command Line Interface.

5.2.5. Operations

5.2.5.1. Create CNC Job

Parameters:

•	Cut Z: Drill depth below the copper surface. E.g. -0.1.
•	Travel Z: Distance above the copper while moving in the X-Y plane.
•	Feedrate: Tool speed while drilling (Z axis movement) in units per minute. E.g. 50.
•	Tool change: If set, will include tool changing sequence in the resulting G-Code.
•	Tool change Z: Distance from the copper surface to lift the tool for it to be changed. E.g. 1.2.
•	Tools: List of tools that will be included in the CNC Job.
Creates a CNC Job Object for drilling.

A CNC Job for the Excellon object can be created via the object’s GUI or the drillcncjob command in the Shell Command Line Interface.

5.2.5.2. Mill Holes

Parameters:

•	Tool dia: Diameter of the milling tool.
•	Tools: List of tools that will be included in this operation.

Creates a Geometry Object with tool paths for milling holes specified in the Excellon object.

5.3.  Operations

5.3.1.  Export G-Code

Parameters:

• Prepend to G-Code: Any text provided will be added at the beginning of the G-Code file.
• Append to G-Code: Any text provided will be added to the en of the G-Code file.
• File Name: Name of the file to write.

Saves the G-Code of the Object in the specified file.

This operation is available in the object’s GUI and through the write_gcode command in the Shell Command Line Interface.

6. Geometry Editor

6.1. Introduction

The Geometry Editor is a drawing CAD that allows you to edit a FlatCAM Geometry Object or create new ones from scratch. This provides the ultimate flexibility by letting you specify precisely and arbitrarily what you want your CNC router to do.

6.2. Creating New Geometry Objects

To create a blank Geometry Object, simply click on the menu item Edit→New Geometry Object or click the New Blank Geometry button on the toolbar. A Geometry object with the name “New Geometry” will be added to your project list.
 
[image: _images/drawing_toolbar.png]

6.3. Editing Existing Geometry Objects

To edit a Geometry Object, select it from the project list and click on the menu item Edit→Edit Geometry or on the Edit Geometry toolbar button.

This will make a copy of the selected object in the editor and the editor toolbar buttons will become active.

Changes made to the geometry in the editor will not affect the Geometry Object until theEdit→Update Geometry button or Update Geometry toolbar button is clicked. This replaces the geometry in the currently selected Geometry Object (which can be different from which the editor copied its contents originally) with the geometry in the editor.

6.3.1. Selecting Shapes

When the Selection Tool is active in the toolbar (Hit Esc), clicking on the plot will select the nearest shape. If one shape is inside the other, you might need to move the outer one to get to the inner one. This behavior might be improved in the future.

Holding the Control key while clicking will add the nearest shape to the set of selected objects.
6.3.2. Creating Shapes

The shape creation tools in the editor are:

• Circle
• Arc
• Rectangle
• Polygon
• Path

[image: _images/editor2.png]
 
After clicking on the respective toolbar button, follow the instructions on the status bar.
Shapes that do not require a fixed number of clicks to complete, like polygons and paths, are complete by hitting the Space key.

Certain shape tools can have different options or modes. By hitting o and/or p the tool will cycle through its options and/or modes.

6.3.3. Union

Clicking on the Union tool after selecting two or more shapes will create a union. For closed shapes, their union is a polygon covering the area that all the selected shapes encompassed. Unions of disjoint shapes can still be created and is equivalent to grouping shapes.
t[image: _images/editor_union.png]

6.3.4. Intersection

Clicking on the Intersection tool after selecting two or more shapes will create a new shape from the intersection of the selected shapes. The original shapes are deleted.

6.3.5. Subtraction

Multiple tool shapes can be subtracted from a target shape. Select the target shape first, then tool 1, tool 2, etc. and click on the Subtraction tool button. The original target shape is deleted, and a new geometry consisting of the target minus the tool shapes is created. The tool shapes remain untouched.

6.3.6. Cut Path

Multiple tool shapes can be subtracted from a target shape, which is first converted to the linear paths of it’s boundary. Select the target shape first, then tool 1, tool 2, etc. and click on the Cut Pathtool button. If no tool shapes are selected the target is simply converted from a polygon to its linear boundary.
[image: _images/subtraction_cut.png]
Difference between the Subtraction and Cut Path operations.

6.3.7. Moving and Copying

The Move and Copy tools work on selected objects. As soon as the tool is selected (On the toolbar or the m and c keys) the reference point is set at the mouse pointer location. Clicking on the plot sets the target location and finalizes the operation. An outline of the shapes is shown while moving the mouse..

6.3.8. Cancelling an operation

Hitting the Esc key cancels whatever tool/operation is active and selects the Selection Tool.

6.3.9. Deleting selected shapes

Selections are deleted by hitting the - sign key.

6.3.10. Grid and Snap

The coordinates entered by clicks of the mouse can be made to “snap” to certain predefined coordinates. These are the grid coordinates and coordinates in shapes already entered in the editor. Snapping to either of these can be turned on and off separately by clicking on the corresponding buttons on the toolbar.

Snapping to the grid coordinates applies to the whole drawing canvas. Wherever you click, the coordinates given to the program are those of the nearest grid coordinated. The grid coordinates are defined by specifying the grid spacing for the X and Y axes in the corresponding inputs in the toolbar.

Snapping to shape coordinates applies only when the pointer is within a minimum distance of the nearest point in the shape. This minimum distance is specified in the corresponding input in the toolbar. If within this minimum distance, then the coordinates given to the program are those of the nearest point in the shape. If beyond this minimum distance, snapping to shape coordinates is ignored and will snap to the grid if also enabled.

A small dot in the drawing canvas provides a preview of where the pointer would snap.

7.  EAGLE HOW-TO

Quick guide on exporting PCB designs from Eagle and importing them into FlatCAM. This guide was made with Eagle version 7.2.0 Light and FlatCAM 8.2.
Most designs start with schematics of your circuit:

[image: _images/eagle_example_1.png]

Then by clicking on File→Switch to board, the board editor is opened and you can complete your layout:

[image: _images/eagle_example_2.png]

To export Gerbers, go to File→CAM Processor in the board editor, and choose the settings shown in the figure below. Include the copper layer that you want to export and the Pads and Vias layers. Choose a proper name for your output file and click Process Job. Repeat for each desired layer.
[image: _images/eagle_example_2.png]

For drill files, go to File→CAM Processor again and select the settings in the figure below. Do not provide an extension to the drill file name. Click on Process Job to export.
 
[image: _images/eagle_example_4.png]
We are done with Eagle. Now let’s move on to FlatCAM.

Eagle uses Trailing Zeros in its Excellon number format but does not properly report this format in the Excellon file. To tell FlatCAM to use this format by default set this system option excellon_zerosto T by using the set_sys command in the Shell Command Line Interface as shown below:

[image: _images/eagle_example_5.png]

The command get_sys excellon_zeros is optional and only lets you see what the excellon_zerosoption was set to originally.

Note

Changes to system options are persistent. They will remain set to the given value when you restart.
This completes all the adjustments. Now simply open the Gerbers and Excellon files that you exported from Eagle.
[image: _images/eagle_example_6.png]
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 MANUAL DE USUARIO DE LA MÁQUINA CNC
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Esta máquina CNC está diseñada para hacer placas PCB de gran precisión. Cuenta con una unidad de control que está basada en un Arduino UNO y un software llamado GcodeSender que sirve de interfaz gráfica de usuario; este no permite comunicarnos con la unidad de control que comanda la máquina con GRBL, software diseñado para el control de máquinas CNC.

La máquina está conectada directamente a la unidad de control y esta a su vez a la computadora por medio de un cable USB como el que se muestra en la siguiente imagen.
[image: C:\Users\JoseEnrique\Desktop\ANEXOS\e9edb15b4f9a_img.jpg]
PARTES DE LA MÁQUINA CNC.

Las partes principales de la máquina se detallan en la siguiente imagen.

[image: C:\Users\JoseEnrique\Desktop\ANEXOS\PARTES MAQUINA.png]

Motor eje Z: Este motor gobierna el movimiento del eje Z, motor paso a paso de 200 pasos, 2A.
Motor eje X: Este motor gobierna el movimiento del eje X, motor paso a paso de 200 pasos, 2A.
Motor eje Z: Este motor gobierna el movimiento del eje Z, motor paso a paso de 200 pasos, 2A.
Motor Spindle: Motor DC controlado por PWM, hace que la herramienta gire para poder realizar el fresado.
Boca de Herramienta: Sirve para ajustar la herramienta o fresa, igual al mandril de un taladro.
Base de trabajo: Es el lugar donde se sostienen las baquelitas para poder fresarlas.
Cables de conexión: Cables que reúnen conexiones de los motores y de los finales de carrera ubicados en el eje X, Y.

Cada uno de los cables de conexión tienen marcas que muestran el motor al cual pertenece como se muestra en la imagen siguiente.
[image: C:\Users\JoseEnrique\Downloads\12235695_905003176215814_1617578429_o.jpg]

PARTES DE LA CAJA DE CONTROL:

[image: C:\Users\JoseEnrique\Desktop\ANEXOS\CAJA.png]
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CALIBRACIÓN DEL EJE Z:

· CALIBRACIÓN POR VISIÓN DE OPERARIO.

Esta calibración es la menos efectiva pero no deja de ser una calibración que se puede utilizar, para esto se debe bajar manualmene el eje Z girando el respectivo motor y observar que la punta de la fresa toque apenas la suerficie de la baquelita, como se puede ver en la siguiente imagen.

[image: C:\Users\JoseEnrique\Downloads\12190668_900327813350017_1075451318_o.jpg]

· CALIBRACIÓN POR MEDIO DE CONTINUIDAD

Esta calibración suele ser un poco mas efectiva que la anterior, para esta podemos usar un multímetro para medir la continuidad entre la fresa y la baquelita aprovechando que los dos tienen superficie metálica. Simplemente se conecta una punta del multímetro a la fresa y otra a la baquelita, posteriormente se baja el eje Z hasta que el multimétro emita un sonido y es entonces en ese momento que la punta de la fresa estará en el punto cero.

[image: C:\Users\JoseEnrique\Downloads\12194191_900327833350015_357280227_o.jpg]

· CALIBRACIÓN POR MEDIO DE UN DISPOSITIVO DE CONTACTO Y SOFTWARE

Esta sin duda es la calibración mas efectiva que se puede usar, existen en el mercado sondas de contacto que nos ayudan a calibrar el eje Z con mucha exactitud; es posible también diseñar una sonda de contacto, esto sería hacer un circuito donde la punta de la fresa y la baquelita se comporten como un interruptor y encender un led cuando este se cierre por el contacto.

Ya no se necesitaría mover manualmente el motor para bajar el eje Z, mas bien se utilizaría un movimiento por el software, enviando un movimiento de un paso hasta que la punta de la fresa toque la baquelita, luego apagar la máquina y guardar esta posición como origen.

GCODESENDER: INTERFAZ GRÁFICA DE USUARIO.

Una vez realizadas todas las conexiones entre la máquina y la caja de control se debe conectar el cable USB en una computadora y abrir GCODESENDER.

A continuación una explicación del manejo de GCODESENDER: 

Cuando se inicia GCODESENDER, muestra la siguiente pantalla.
[image: ]

En la parte de Connection la configuración es la siguiente.

[image: ]

En la ventana de Port se debe escoger el puerto al que el Arduino está conectado; si no se conoce el puerto, se puede acceder al administrador de dispositivos y averiguarlo.

En Baud se elige la velocidad de comunicación, que en este caso es de 9600 Baudios.

Lo siguiente es dar clic en OPEN para abrir la comunicación entre Arduino UNO y el ordenador.

En Firmware, se debe dejar la opción GRBL que es el software cargado Arduino UNO.

Despues de estos pasos GRBL debe responder con el siguiente mensaje en la ventana de consola.

[image: ]

· Sección de Estado de la máquina.

[image: ]

Esta sección muestra la posición actual de la máquina y la posición según el código-g en los tres ejes.

· Consola:

La consola sirve para poder ver el código-g que se va ejecutando, la configuración actual con comandos $$, y los mensajes de alarmas errores, etc.

[image: ]








· Menú:

[image: ]

En el menú de Gcodesender se encuentra la ventana de comandos, modo de archivo, control de la máquina, y macros.

En este proyecto se usó las tres primeras pestañas.

Comandos: Esta ventana sirve para configurar los parámetros de GRBL a través de comando $$.

File Mode: En esta pestaña se busca el archivo de código-g guardado en el ordenador.

[image: ]

Después de este paso se puede usar el visualizador para ver la placa que se va a fresar.
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En la imagen anterior se puede observar un objeto amarillo, este es la herramienta que se irá moviendo para completar el ciclo de fresado.

Control De La Máquina:

En esta pestaña se encuentra algunos botones, en la parte izquierda está:

· Reset Zero: Sirve para poner cualquier posición de la máquina como punto cero.
· Return Zero: Con este botón la máquina regresa a su posición de cero desde cualquier posición en la que se encuentre.
· Soft Reset: Resetea el software ante cualquier falla, después de resetear se debe hacer clic en el siguiente botón llamado $X que desbloquea el software para poder usarlo nuevamente.

Al lado derecho se encuentran los botones de movimientos manuales, en la parte superior se puede escoger el tamaño del paso y la unidad (mm o pulgadas).

También se puede activar y desactivar el uso del teclado para los movimientos manuales.

[image: ]

Una vez cargado el cógido-g se presiona el botón de Send, enviar y el trabajo comenzará mostrándonos en la ventana de consola las coordenadas de cada movimiento de la máquina.

[image: ]

Se puede usar el botón de Pause para poder hacer descansar la máquina ante cualquier calentamiento excesivo en los motores paso a paso.

El botón Cancel se debe usar en caso de notar alguna anormalidad en el proceso de fresado.
También se puede usar el botón de paro de emergencia por si se presenta alguna falla en el trabajo, este botón función de manera más rápida que el botón cancel ya que este último necesita de una confirmación para poder cancelar el proceso.

Una vez finalizado el fresado sin ningún problema el software responderá con un mensaje como el que se muestra en la imagen siguiente.
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Toda esta información se encuentra en el canal de Youtube Enrique Gaibor ESPCOH en video tutoriales realizados por los propenentes de este trabajo de investigación, con esto se puede incrementar los conocimientos para poder realizar un fresado adecuado y con resultados asombrosos.




Máquina herramienta convencional


 Un operario solo puede manejar una sola máquina.


 Es necesario consultar constantemente el plano.


Máquina herramienta CNC


 Un operario puede operar varias máquinas.


 No es necesario consultar apenas el plano.


 Se necesita una amplia experiencia. 


 El operador tiene el control de profundidad, avance, etc.


 Mecanizados imposibles de realizar.


 No es necesario una amplia experiencia.


 El programa tiene todos los parámetros de corte.


 Posibilidad de realizar practicamente cualquier mecanizado  
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